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CHANGES FOR 2024  

There have been a number of changes to the BGA Rules for Rated Competitions for the 

2024 competition season. Listed here are the most important rules changes with the section 

number identified.  

Please remember that you are responsible for delivering a fair and safe competition. The 

rules are designed to facilitate this and reduce the opportunity for argument when dealing 

with infringements. Please use your Director’s report to provide feedback to the competitions 

committee to highlight any problems encountered that may be resolved by revisions to the 

rules for the 2025 season. 

 

• Involvement of host club CFI (1.1.2) Paragraph added to require that the club CFI 
or delegate be appointed as a competition official. 
 

• Multi-seat gliders (2.1.6) Change in the definition of most proficient pilot. 
 

• Role of PSC (5.1.1) Paragraph added that PSC will be used by the Director to 
consider flying that may result in a non-specific dangerous flying penalty. 
 

• Responsibility of PIC (5.2.2) Paragraph added reminding pilots that they are 
responsible for the safe conduct of their flight. 
 

• Definitive task and rules (5.2.5) Paragraph added to clarify. 
 

• Mandatory Safety Briefing (5.2.6) Rule added to mandate attendance of all pilots. 
 

• Use of airspace after land out (5.10.8) Rule added to allow transit of airspace when 
returning to site. 
 

• Start Calls (5.6.8) Rule deleted. Start calls are no longer required. 
 

• Self-launcher release height (5.22.1) Rule simplified, and contradiction resolved. 
 

• Turbo test procedure (5.22.2) Rule rewritten to simplify and clarify the required 
procedure for testing for serviceability and logging. 
 

• Selection of British Team (6.2) CC discretion removed and placed with BGA Exec 
 

• Penalties (7.1) Penalty for flying outside certified limits deleted. 
 

• Glider Speed Indices (7.3) LS8 Neo increased to 100.5 
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INTRODUCTION 
This document is a step-by-step reference guide to help gliding clubs organise and run a 

British Gliding Association Rated Competition. It is regularly up-dated to cover changes to 

the Rules for Rated Competitions, however for the definitive rules or decisions concerning 

competitions you should use the annually up-dated Rules for Rated Competitions.  

There are four parts: 

Part 1 “Preparation” explains the decisions you have to make and the things you have to 

put in place to get your competition to happen. 

Part 2 “During the Competition” gives in-depth advice on the things you must do and the 

standards you should aim to achieve in the competition itself. 

Part 3 “Checklists” are lists of the essential elements arising in each of the main disciplines 

or activities involved in the competition and are included to help you avoid forgetting 

something important. 

Part 4 “Reference” contains information of a technical or complex factual nature. 



BGA Competition Organisers’ Guide 

April 2024                          ©British Gliding Association 2024 Page 3 of 81 

INTRODUCTION ................................................................................................................... 2 

PART 1 - PREPARATION .................................................................................................... 6 

1.1. BGA Requirements ......................................................................................................................... 6 

1.2. Local Arrangements ....................................................................................................................... 6 

1.3. Launching Capabilities .................................................................................................................. 6 

1.4. Infrastructure Arrangements ......................................................................................................... 6 

1.5. Organisational Team ...................................................................................................................... 7 

1.6. BGA Notification of Director and Club Contact Details .............................................................. 7 

1.7. Roles and Responsibilities ............................................................................................................ 7 

1.8. Use of the Internet and Social Media ............................................................................................ 8 

1.9. Entry Administration ...................................................................................................................... 9 

1.10. Local Procedures ......................................................................................................................... 9 

1.11. Publication of Competition Airspace Files ..............................................................................10 

1.12. Emergency Action Plan .............................................................................................................10 

1.13. Competitors are “Customers” ..................................................................................................11 

1.13. Top-Level Timeline .....................................................................................................................12 

1.14 Child Safety and "Safeguarding"…………………………………………………………………….11 

1.15 Top-Level Timeline……………………………………………………………………………………...12 

PART 2 – DURING THE COMPETITION ............................................................................ 15 

2.1. The Role of the Director ...............................................................................................................15 

2.2. Competition Control .....................................................................................................................15 

2.3. Registration ...................................................................................................................................16 

2.4. Safety .............................................................................................................................................17 

2.5. Airfield ...........................................................................................................................................20 

2.6. Airspace ........................................................................................................................................21 

2.7. Penalties. .......................................................................................................................................25 

2.8. Task-Setting ................................................................................................................................255 

2.9. Distance Handicapped Tasks ......................................................................................................30 

2.10. Daily Briefing ............................................................................................................................322 

2.11. Met Briefing .................................................................................................................................33 



BGA Competition Organisers’ Guide 

April 2024                          ©British Gliding Association 2024 Page 4 of 81 

2.12. General Communications ..........................................................................................................34 

2.13. Competition Radio ....................................................................................................................355 

2.14 Misuse of Radio and Digital Communications Enforcement Guidelines ..............................35 

2.15. Gridding .......................................................................................................................................36 

2.16. The Decision to Launch .............................................................................................................38 

2.17. Launching ...................................................................................................................................39 

2.18. Starting ........................................................................................................................................40 

2.19. Task Cancellation .......................................................................................................................41 

2.20. Finishing ......................................................................................................................................41 

2.21. Scoring ........................................................................................................................................43 

2.22. Penalties ......................................................................................................................................46 

2.23. Competition Forums and Feedback .......................................................................................488 

PART 3 – CHECKLISTS ..................................................................................................... 50 

3.1. Getting Started ..............................................................................................................................50 

3.2.  Airspace .......................................................................................................................................52 

3.3.  Safety ............................................................................................................................................53 

3.4.  Control ..........................................................................................................................................54 

3.5.  Meteorology .................................................................................................................................55 

3.6.  Task Setting .................................................................................................................................56 

3.7.  Ground Marshalling .....................................................................................................................57 

3.8.  Scoring .........................................................................................................................................58 

PART 4 – REFERENCE ...................................................................................................... 59 

4.1  Example of the Daily Schedule at a Single-Class Regionals ...................................................59 

4.2.  Task Sheet Specification ............................................................................................................64 

4.3.  Creating the Task Sheet..............................................................................................................66 

4.4.  Competition Airspace Files ........................................................................................................68 

4.5.  Scoring .........................................................................................................................................70 

4.6.  Height Verification Procedure ....................................................................................................78 

4.7  Weighing Procedure .....................................................................................................................79 

4.8  Directors Report ...........................................................................................................................80 



BGA Competition Organisers’ Guide 

April 2024                          ©British Gliding Association 2024 Page 5 of 81 

 



BGA Competition Organisers’ Guide 

April 2024                          ©British Gliding Association 2024 Page 6 of 81 

PART 1 - PREPARATION 
 

With a significant period of pre-planning your competition is likely to be a success. Pre-

planning encompasses a number of tasks that could be delegated to other members of your 

organisation.  

1.1. BGA Requirements 

The BGA shall require the organising club to have agreed competition dates before the 

December of the preceding year. The BGA shall require that a minimum level of competence 

and capability exists within the organisation team. The BGA can provide advice on this as 

required. Email compscommittee@gliding.co.uk or look for the “BGA Competition Organisers 

Forum” on Facebook. 

1.2. Local Arrangements 

It is important that other local arrangements are taken into account at the earliest opportunity. 

Ensure that any planning and neighbouring airfield requirements are identified and are 

suitably addressed before a competition date is decided. Any significant local arrangements 

that could affect the competitors shall be included in the local rules; see the Local 

Procedures Section for more detail. 

1.3. Launching Capabilities 

BGA Rules require that all competition gliders in any task group are launched within 1 hour. 

This is a minimum standard. Minimizing the launch time increases opportunity for pilots to get 

the best out of a small window of opportunity. 

In order to achieve the required launch rate it shall be necessary to identify the correct 

number, type and availability of tugs well in advance of the competition.  Remember that 

large heavily ballasted gliders shall need more powerful tugs, so try to predict the mix of your 

expected entries and plan accordingly.  As a rule of thumb, expect each launch to take ten 

minutes, so the minimum number of tugs for a 30-glider grid would be five. Allowing an extra 

one for breakdowns, that means you should look to have six available. 

Tug availability becomes notoriously difficult during the peak summer months so you should 

start to contact tug owners and operators well in advance, in fact as soon as you have 

decided on a date.  You may even want to take tug availability into account when deciding 

which date to go for.  If your dates clash with some of the big competitions, you may have a 

problem.  If you do find yourself short of dedicated tugs, you can try arranging for tugs to 

ferry-in from local clubs just for your launch period. This is not ideal and can be expensive. 

1.4. Infrastructure Arrangements 

Actions to ensure that your club has the necessary facilities for the competition need to be 

identified at the early planning stages. Additional photocopiers, public address systems, 

briefing room facilities, catering, phone and internet requirements may be necessary to 

ensure the smooth running of your competition.  

mailto:compscommittee@gliding.co.uk
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1.5. Organisational Team 

Working together is prerequisite to ensuring a successful competition.  It is recommended 

that the organisation team should include some people who have been involved in the 

running of competitions before. Where this is not possible, the team should consider 

practicing, in advance, key areas of running a competition. 

1.6. BGA Notification of Director and Club Contact Details  

If your competition could involve 20 or more gliders, whether it is rated or not, the BGA 

should be informed of the Director and Club contact details at the earliest opportunity. These 

will be used by the BGA to arrange airspace co-ordination with NATS (see ACN in Section 

2.6) as well as to establish a line of communication for updates to the organising club 

throughout the year. The following detail is required and shall be emailed to both the 

Competitions and Awards Committee and the BGA Competition Airspace Co-ordinator at the 

following two addresses: 

compairspace@gliding.co.uk and compscommittee@gliding.co.uk : 

• Name of Competition. 

• Start and End Dates. 

• Organising Club and Club email address.  

• Club telephone number. 

• Location.   

• Number of Gliders expected. 

• Number of Tugs Expected. 

• VHF Channel to be used for finishing. 

• Name of Director. 

• Director’s email address and mobile telephone number during event. 

Where clubs have a problem with releasing personal contact details of individuals, 

consideration should be given to providing depersonalised email addresses 

(director@thiscomp.uk) and the use of a low-cost pre-paid mobile telephone during the 

competition. 

1.7. Roles and Responsibilities 

To ensure that your organisation works together as a team to run a safe and well organised 

competition it is important that each role within the team is defined. 

Competition Director 

The Director has overall responsibility for ensuring that suitable personnel, equipment and 

facilities are available for the safe, efficient organisation and running of the competition. 

Directors shall be fully conversant with the BGA rules and are responsible for ensuring 

compliance with these. 

Directors should also double-check tasks to ensure safe routing, especially of routing through 

ATZs, RA(T)s, final glides, etc. 

mailto:compairspace@gliding.co.uk
mailto:compscommittee@gliding.co.uk
mailto:director@thiscomp.uk
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The Director should maintain an overview of the competition to ensure that all elements are 

being brought together to achieve a successful competition. 

Key Officers 

The Competition Director must appoint the following key officers as a minimum: 

• Deputy Director  

• Task Setter }  

• Airspace Officer } 

• Safety Officer 

• Club CFI or delegate.  

Control 

“Control” refers to the admin and communications centre of the competition. Usually this is a 

dedicated area set up by the host club which is equipped to deal with all of the administration 

and communication tasks associated with the competition.  This can be used as a base and 

meeting point for the Director and Competition Officials.  A well-run and well-equipped 

Control Centre is a major asset at a competition. While it is not necessary for the operation of 

Control to be under a single individual, it does need to be run by competent people who are 

familiar with, or can be trained in advance in the processes. 

Additional Roles 

Additional roles will be required to run the competition. It is good practice to assign these 

roles to individuals; not only does this empower the individuals, but it should also allow the 

Director to maintain an overview of the entire competition.  While one individual may take on 

more than one role it is important the Key Officers should not have additional duties placed 

upon them which may impact on their ability to perform their primary role. 

Additional roles which will be required: 

• Scorer 

• Meteorological interpreter and presenter  

• Launch Marshall / Chief Grid Marshal 

• Tug Master  

• Catering Manager  

• Social Organiser  

 

1.8. Use of the Internet and Social Media 

The internet is pretty much inescapable for organisations wanting to run a gliding competition 

nowadays. It can be used for benefit in so many ways. 

Competition Management  

You may wish to make use of a specialist competition management package, such as 

Robocontrol or you may prefer to set up you own home-grown system.  However you do it, 

pilots will expect to be able to apply to enter your competition on-line. 

Communication during the Competition 

The internet can be a valuable way of distributing information to the pilots during the 

competition. If you are using a home-grown website for your competition, consider building a 

These two roles must not be the same person. 
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page that competitors can access to get information such as briefing times, grid-before 

briefing instructions, NOTAM files, Airspace files etc.  

Real-time Competition Reporting 

The gliding community nowadays expects to be able to follow competitions on-line. (It’s 

about nurturing the dream). Don’t neglect this side of things. Today’s on-line followers may 

be next year’s competitors.  Publishing a competition blog and posting photographs can 

really enhance the reputation of your competition and your club. Specialist packages can be 

used, but a lot can be done with sites like Facebook and Flickr. 

1.9. Entry Administration 

As soon as your competition is open for entries, you can expect to receive enquiries, entries 

and deposit payments.  To ensure that these are handled correctly it is important that these 

are administered carefully.  You may wish to consider a web-based system that can visibly 

show the status of pilots who have entered.  Consider having a separate bank account for 

monies received as reconciliation of the entry fees can be notoriously difficult if not 

administered correctly.  However, more importantly, ensure that a protocol has been agreed 

with the club’s office and committee as to how competition communications and payments 

are to be handled; some competition organisations prefer to manage communications within 

the competition team, whereas others leave the communications and chasing of payments to 

the club office. 

1.10. Local Procedures 

Rule 1.3 of the Competition Rulebook defines the requirement for Local Procedures (or Local 

Rules as they are more commonly called).  

This is an important document that the organising club will have to write, obtain approval for, 

and publish no later than three weeks before the competition.  Local Rules are normally 

published on the competition website or emailed to participants.  If you don’t already have a 

template for this document at your club, go online and have a look at some of the documents 

published on other competition web-sites. This should give you an idea of what the 

competitors will be expecting.  

An important requirement is that details of temporary airspace restrictions already 

announced at the time of publication should be included in the Local Rules. It is appreciated 

that many restrictions crop up by NOTAM with little warning, but many are known months in 

advance including RA (T) protecting Red Arrows displays and other critical activity.  

Publishing the known stuff early helps to minimise the amount of new information that must 

be absorbed by the pilots at the beginning of the competition. 

As well as other content required by the Rule Book, the local rules shall contain a reminder to 

fly within the requirements of the Law, namely the UK implementation of SERA 

(Standardised European Rules of the Air) and its associated UK exceptions regarding low 

flying and reckless or negligent endangerment of any person or property.    

The local rules shall identify the boundary of the airfield. 

Care should be exercised in defining the boundary of the airfield taking the following key 

factors into consideration: - 
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• Legal status 

• Landowner’s permission 

• Airfield insurance cover 

• Public safety (access and H&S) 

• Aviation safety 

The Competitions and Awards Committee must approve all Local Procedures. Please submit 

them in good time by email to compscommittee@gliding.co.uk. If you are not contacted 

about your Local Rules within 14 days, then you can assume they are acceptable, but every 

effort will be made to confirm acceptance as appropriate within this time. 

1.11. Publication of Competition Airspace Files  

These days there is almost universal use in gliding competitions of moving map displays as 

aids for navigation and airspace awareness.  Many types of equipment are available and 

there is more than one format and several potential sources of airspace files.  There is a 

strong possibility that pilots in your competition may be using airspace files which differ 

significantly from each other and (more importantly) from the file that you will be using for 

scoring and for checking for prohibited airspace penalties.   

To help pilots to be on the “correct” airspace file and to avoid any misunderstanding, it is 

highly recommended that the airspace file which will be used by the organisation for scoring 

and infringement checking should be published. Pilots can, if they wish, make use of it 

themselves, or, if they do not, they will at least have been given the opportunity. Details of 

the file and where it can be downloaded should be given in the Local Rules.  

If temporary airspace restrictions are known to affect your competition, you may wish to 

include these in your “Official Airspace File”.  Likewise, if you intend to make use of any of 

the established airspace concessions (E.G. The Daventry Box), you may want these 

represented in your file as well. 

Whether you want to use a competition-specific file or simply one that matches the latest 

CAA chart (plus amendments), the new ASSelect website produces OpenAir airspace files 

that are compatible with most devices and the SeeYou scoring system. The site also offers 

the ability to add upcoming RA (T)s. Before publishing an airspace file to competitors, 

consider how ILS feathers, Danger Areas, Unlicensed Airfields etc. should be displayed. 

More information on airspace files can be found in the Reference section. 

The Competitions & Awards Committee can advise further on airspace files and airspace 

scoring procedures as required. 

1.12. Emergency Action Plan 

The pre-planning to the event should establish an emergency action plan so that operational 

and communication systems are available for the possibility of an unplanned event. 

It is recommended that this system is known to all key personnel before the competition and 

areas that require testing are practiced, where necessary, before the start of the competition. 

The emergency action plan should be able to deal with the following, non-exhaustive list: 
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• Off-site or on-site accident involving damage to one or more aircraft. 

• Off-site or on-site accident involving injury or fatality to one or more persons. 

It may be necessary to have a reactive press briefing available for any of the above and/or 

mechanisms to ensure that unnecessary media access to any incident does not impede the 

emergency services. 

If your club does not already have an emergency plan which can be adapted to cover the 

needs of the competition, you are strongly encouraged to make use of the BGA’s published 

Post Accident Plan. This is an excellent template on which to base your own Emergency 

Action Plan.  It can be downloaded from the BGA website at:  

www.gliding.co.uk/bgainfo/safety/forms/postaccidentguide.pdf 

1.13. Competitors are “Customers” 

One final, but very important, point is the need to treat your competitor’s right. You won’t go 

far wrong if you just remember that they are your customers and treat them accordingly.  

They will have paid money to enter your competition and are likely to spend considerable 

sums at your club during the competition. They will probably have taken time off work and 

will be on holiday. It’s your organisation’s responsibility to make their experience as pleasant 

as possible. Don’t forget that it’s not just the flying that counts. Everything from the quality of 

communications, the club facilities, the friendliness of club-members and competition 

officials, to the quality of the catering and the availability of evening and scrub-day 

entertainments are just as important as the quality of the briefing and task-setting. If you want 

places at your competition to be in demand, you will need to pay attention to all of these 

things. 

1.14  Child Safety and “Safeguarding” 

When a competition has a significant number of U18 pilots, there is an increased duty of care 

requirement for the club and competition organisers. The welfare of U18 pilots must be 

treated as a very important matter and must not be taken lightly; just a single incident 

involving child welfare could have significant repercussions for the Competition/Club. 

Fortunately, the BGA has a Junior Gliding centre officer that can be approached who can 

advise and there are numerous BGA on-line publications to ensure your club is not put into 

an adverse duty of care position. These include provisions relating to DBS checks, 

role/contact with parents, reporting incidents involving children, etc.  

 

Reference for further information is:-  

https://members.gliding.co.uk/club-management/membership-participation/managing-visiting-

under-18s/ 

 

 
  

http://www.gliding.co.uk/bgainfo/safety/forms/postaccidentguide.pdf
https://members.gliding.co.uk/club-management/membership-participation/managing-visiting-under-18s/
https://members.gliding.co.uk/club-management/membership-participation/managing-visiting-under-18s/
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1.15. Top-Level Timeline 

The following table provides an overview of the major decision and action points that need to 

be addressed by a club wishing to organise a competition. 

When What Who Notes/Detail 

On decision to 

bid for a 

Nationals or 

Championship 

Event 

Prepare Bid Document and submit Host Club 
Respond to Invitation to bid sent out to Club 

Chairmen by the BGA 

On Decision to 

Host a 

Regionals or 

Unrated Event 

Register your competition with the BGA Host Club 
Submit competitions details to the BGA by 

March 1st at the latest. 

9 months to 1 

year ahead 

Appoint Director and Organising 

Committee (OC)  
Host Club 

See “Organisational Team” in Part 1 of this 

Guide. 

ASAP If 

Regionals or 

Unrated 

Decide entry numbers and whether 

single or multi-class 

Director 

OC 

This could be flexible depending on entry 

numbers, but needs to be planned 

ASAP 
Read the Organisers Guide From Cover 

to Cover 
See Note 

Anyone not experienced in running 

competitions. 

Periodically 

until 

Competition 

opens 

Organising Committee Meetings (in 

person or as telephone conferences) 
OC 

Develop action plan based on main headings 

below. Review progress against plan. Take 

prompt action to contain slippages and 

rectify problems. 

ASAP 
Allocate Official Roles and review other 

manpower requirements 

Director 

OC 

See “Roles & Responsibilities” in Part 1 of 

this Guide.  Try to arrange that every key role 

has a back-up in case of illness or absence 

during the competition. 

ASAP Review infrastructure and site facilities 

Director 

OC 

Identify any weaknesses and develop plans 

to rectify, if necessary. See “Infrastructure 

Arrangements” in Part 1 of this Guide. 

ASAP Review tug availability 
Tug-

master 

Take early action to source any additional 

tugs that will be required. See “Launching 

Capabilities” in Part 1 of this guide. 

ASAP Review Communication and Radios OC 
See “General Communications and 

“Competition Radio” in Part 2 of this Guide 

ASAP 
Start work on Catering, Entertainments 

and/or social planning 
OC 

Develop a programme of events for scrub 

days and evenings.  

ASAP 

Decide Entry Fee, Deposit amount and 

due dates. Also, policies regarding 

discounts/refunds etc.  Identify any other 

charges you plan to make (e.g. Caravan 

pitches, bunk house fees etc.) 

OC 

If you are running a Nationals, much of this 

will have been in your bid, so will be fixed.  

 

Make sure you anticipate any questions you 

might be asked by potential entrants 
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ASAP 

Set up Admin system for management of 

entries and receipt of fees. Include 

procedure for management of a waiting 

list if the competition fills up 

OC 

See “Entry Administration” in Part 1 of this 

Guide.  Make sure you have this in place 

before publicising your competition 

ASAP 

Publicise Competition.  

Dates, Entry Fees etc. 

OC 

Several routes are available for this, including 

printed media such as S&G, although the 

Internet is now the default medium. See “Use 

of the Internet” in Part 1 of this guide. 

As entries are 

made 

Acknowledge entries and the receipt of 

deposits and balances by email 

Comp 

Admin 
Don’t leave your customers in the dark. 

If competition 

becomes full 
Monitor and manage waiting list 

Comp 

Admin 

Keep waiting-list pilots informed. 

Communicate promptly when places become 

available. Don’t leave them wondering what is 

going on.  

NLT 2 Months 
Prepare or Review Emergency Action 

Plan  
Safety  

Quarter 1 of 

Competition 

year 

Familiarise with Changes to Rulebook 

for this year and review any Organisers’ 

Briefing Notes from the BGA. 

Director 
Ensure rest of team is briefed where 

necessary 

NLT 2 months 

out 

Monitor airspace changes or issues and 

begin to develop awareness of advance 

NOTAMS and RA(t) for period of 

competition 

Director  

NLT 2 months 

out 

If Competition Airspace file is to be used. 

Make necessary arrangements to 

provide it. 

Airspace 
See “Publication of Competition Airspace 

Files” in Part 1 of this Guide. 

NLT 2 Months 

out  

Write or update Local Rules including 

section on Advance Airspace 

Information 

Director 
See “Local Procedures” in Part 1 of this 

Guide 

6 weeks before 

start 

Submit Local Rules to BGA Comp 

Committee for approval 
Director 

Make sure you allow enough time for the 

approval process to take place, including 

possible amendments, and still be able to 

publish 3 weeks before competition starts. 

NLT 3 weeks 

before start. 

Publish approved Local Rules with 

advance airspace information 
Director  

NLT 3 weeks 

before start of 

Competition 

Publish Competition Airspace file Airspace 
See “Publication of Competition Airspace 

Files” in Part 1 of this Guide. 

NLT 4 weeks 

before start 
Appoint Competition Stewards Director 

3 experienced current competition pilots not 

competing or in an executive role in the 

competition organisation.  

NLT 1 Week 

Before 

Competition 

Prepare Additional Penalty Airspace File 

if to be used 
Tasksetter 

See “How to produce an Additional Penalty 

Airspace File” in Part 3 of this guide 

NLT 1 Week 

Before 

Competition 

Conduct final run-through of processes 

and systems.  
OC While there’s still time to fix any problems 
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Last few days 
Set up competition infrastructure. 

Control, Briefing Areas, Signage, etc. 
OC 

Consider other infrastructure requirements 

such as camp sites, toilets, water ballast 

points, waste management. 

Evening 

Before 

Competition 

Registration Control See “Registration” in Part 2 of this Guide 

Opening Day 

Safety Briefing 

A mandatory safety briefing must be 

held on the first morning of the 

competition and adequate extra time 

should be allocated for this purpose. 

Pilots must attend this event even if the 

pilot has flown at the site in competitions 

on many occasions in the past. A roll call 

must be taken, the briefing may include 

BGA media material if available. Any 

pilot failing to attend must not be 

permitted to fly unless an additional 

private briefing is undertaken, however 

the timing and availability for such a 

briefing is at the sole discretion of the 

Director.  

CFI or 

Safety 

Officer 

Pilots must be briefed on all aspects of safety 

including launching, relighting, best practices 

during the flight, circuit patterns, as well as safe 

and acceptable finishes. 

Opening Day 

Briefing 

To include site and local airspace 

information, rules changes since last 

year and introduction of Comp Officials. 

Appoint Pilot’ Safety Committee. Show 

Prizes and Trophies. Any housekeeping 

issues. 

Director 
Site and local airspace info may need 

repeating or emphasising at daily briefings 

ASAP during 

Competition 

Initial meeting with PSC to confirm 

Terms of Reference 
Director 

See “Pilots’ Safety Committee” in Part 2 of 

this guide. 

Daily During 

Competition 

Publish results at appropriate level. 

Provide competition information via 

Competition Blog or similar service 

Scorer/As 

appointed 

by Director 

Don’t underestimate the value of keeping the 

world at large informed about your 

competition. 

ASAP after the 

competition 

Submit Director’s report to the BGA 

Comps Committee 
Director 

See “Director’s Report” in Part 4 of this 

Guide. 
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PART 2 – DURING THE COMPETITION 
 

2.1. The Role of the Director 

Once the competition gets underway, the Director’s responsibility is to see to it that all the 

resources of the organisation work together to make best use of the available time and 

weather while achieving the standards of safety and sportsmanship expected; all while 

staying within the Rules. See the Reference Section for an example of the daily schedule at 

a single-class Regionals and the activities that have to be managed and the decisions that 

have to be made.   

2.2. Competition Control 

It is good practice to designate a room or area to be used exclusively as an office/meeting 

area for the duration of the competition. As well as providing an office environment for the 

administrative tasks that have to be performed and a place where competition officials can 

meet, it is helpful as a focus for all of the organisational issues that will arise during the 

competition. It also ensures that competitors have a place to go to for help or advice.  

Central Information Point 

Control is where competitors and others will expect to get answers to questions or make 

contact with the Organisation. It is also the place where messages to competitors and others 

can best be managed. As the message hub of the competition, it is the ideal place to site: 

• Competition telephones and computers. 

• Air Band Base Station (for pre-launch announcements and start and finish line 

communications, but see “Start and Finish Line” below)) 

• Ground Radio Base Station (for contacting competition officials out on the airfield) 

• PA system (for making general announcements in the communal areas) 

Ideally the control centre should be manned throughout the competition day. It should be 

lockable. 

Start and Finish Line 

It is essential that gliders in the air can receive clear readable transmissions from the 

organisation on the ground. Start and finish radio communication is best carried out using a 

base station with a decent aerial to ensure adequate range, rather than less powerful hand-

held radios. It is good practice to site the equipment near the control centre. Consider the 

effect that running the start/finish line radio from busy control centre or public viewing area 

might have on the person trying to concentrate on managing the radio. Some clubs use their 

launch vehicles (they often have good radios already installed) or another isolated area to 

manage the start/finish radio, away from the noise of the competition office and control. 

Starts & Finishes 

Although scoring is done exclusively from flight recorder files, it is still a requirement that 

finish times should be recorded as they happen.  Apart from the obvious safety implications 

of knowing whether a glider has started or finished, the recording of this information allows 

crews and others to keep abreast of the progress of the competition (especially if it is 

published on the internet) and may also allow faster calculation and publication of preliminary 
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scores. There is no longer a requirement for pilots to communicate with control to advise 

start times.  

Land-outs 

One of the most valuable tasks of the Control Centre is the coordination of land-out 

information. There should be a dedicated telephone used for this purpose the number of 

which should be printed on all task sheets every day, along with at least one back-up 

number.  Clear procedures should be in place for the reception of land out information and to 

ensure that it is passed to crews accurately without delay. Records should be kept of all land-

outs and the progress of the returning retrieve teams so that all gliders are accounted for 

before the end of the day.  

The Organisation is responsible for invoking the emergency procedure in the case of a 

missing aircraft.  For this reason, it is ABSOLUTELY NOT ACCEPTABLE to permit 

competitors to contact their crews and arrange retrieves without involving Control. The land 

out reporting procedures should be stated in the Local Rules and emphasized at briefings. 

Consideration should be given to applying penalties, if necessary, to enforce this. 

Flight Recorders (FRs) 

With the increased use of removable memory devices and email submission of FR files, 

there is much less need to manage the reception of FRs’. However, not all pilots have the 

most modern equipment or the ability to email traces, so provision should be made to receive 

recorders and removable memory devices after the finish and keep them securely, possibly 

overnight. 

2.3. Registration 

Most BGA competitions start on a Saturday, with competitors arriving on the Friday afternoon 

and evening.  The competition cannot start until this registration process is complete so the 

time available is limited to the few hours available on Friday evening, with a very short period 

to deal with stragglers on the Saturday morning.  If the weather looks good on the first day, 

no-one is going to be pleased with a delayed briefing caused by late registrations. Pilots 

generally understand this and cooperate, although there will be the odd one or two who 

genuinely can’t get to the site until the Saturday morning.  Whatever happens, a major 

priority for the organisers is to ensure that they are on the ball and are NOT the cause of any 

delay.  

Here are some key points to cover in your planning for that all-important Friday evening 

(although it is suggested to use on-line and automated system): 

• Registration area clearly signposted? 

• There will be a queue, can you provide seats?  

• Have a checklist so you don’t forget to do everything with each competitor. 

• You may be taking money (balances of fees and/or launch pre-payments). Have you 

got a process for this? Have you somewhere to put cheques and cash and a process 

for dealing with card payments? 

• A pre-prepared file for registration forms and other competitor information? 

If you are using a web-based competition management system, you will need to have a 

computer with Internet access at the Registration point and someone trained in its use.  
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The BGA registration form is available on the BGA website both in PDF and interactive 

format.  Organisers may create their own online form as necessary as long as it contains all 

the details on the BGA form as a minimum requirement including declaration. 

Those registration forms completed online should be printed off so that pilots may personally 

sign the declaration. The forms must be retained after the event in case of follow-up action 

being necessary. 

It has always been a requirement that every competitor in a UK rated competition holds a 

valid FAI competition licence.  The FAI licence numbers of every pilot must also be detailed 

in the results to be submitted to the BGA as soon after the competition as feasible. Paper 

licenses are no longer issued, but the license database may be interrogated on-line at 

http://old.fai.org/about-fai/fai-sporting-licences. Due to data protection law, only license 

holders themselves can check directly on the website, but there is a facility on the site to 

have license numbers checked in bulk in advance of a competition by obtaining an access 

code. Instructions on how to do this are on the website.  The standard BGA registration form 

includes a field for the pilot’s FAI licence number. This should be checked at registration, 

ideally against a list of competitors’ licence numbers obtained earlier from the database. 

2.4. Safety 

For some clubs, launching and landing arrangements for a competition may not be too 

different from their normal activity. However, for some, the arrangements for launching and 

landing during a competition may require additional measures to be put in place to ensure 

that flight safety is maintained. Note here that there is a requirement to hold a mandatory 

safety briefing prior to the competition starting and before any pilot is permitted to fly 

competitively (see 1.13 above). 

This develops the local arrangements that were introduced during the pre-planning stage of 

the competition organisation. 

Launching and Safety 

Launching any size of grid can be completed in a safe and timely manner if a well-organised 

system is introduced, and practiced, by the organising team.  Think about planning a visit to 

another competition to see how they do it if your launch marshal team is inexperienced.  

Common problems develop in the following conditions: 

• Significant land-backs during a grid launch. 

• Launch failure during grid launch. 

• Re-grid following an abandonment of task. 

• Launching of an alternative class to that gridded. 

• Relighting gliders during the finishing of another class task. 

Although it is difficult to foresee all scenarios, a pre-planning ‘desktop’ exercise to think 

through potential problems can help ensure your launch team don’t get taken by surprise. 

A common problem during launching is that of ensuring that the grid area is clear of 

obstacles during launching, and afterwards if it will be an operational area following the 

successful launching of the grid. 

http://old.fai.org/about-fai/fai-sporting-licences
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All airfield users should be made aware of competition arrangements so that the airfield 

operations are not compromised at any point during the period of the competition. Note that if 

the weather is marginal, you might consider putting the task group that you intend to launch 

first at the front. 

Finishing and Safety 

All airfield users must be especially vigilant during finishing.  The competition rules require 

that the finish procedures are clear to competitors, but it is recommended that this is also 

communicated to all parties to ensure that finishing can be co-ordinated with other operations 

occurring at the site. A ‘fail safe’ system should be utilized to prevent communication errors 

occurring in any procedure that is developed locally to deal with ground and air operations. A 

risk of an incident is increased significantly if procedures are not established for the following, 

but not exhaustive, scenarios: 

• Finishers that have lost radio communication 

• Finishers that use the wrong finish line 

• Finishers that land on a non-active runway 

• Finishers that finish in opposing directions to the normal operations 

• Finishers that finish in a pre-briefed pattern which conflicts with current operations. 

The Rules require that the Director or his designated key officer monitor the finish to ensure 

that the conduct of flying is continually observed and to enable communication, where 

necessary, with landing aircraft. Staffing and briefing of finish line officials should reflect this 

requirement. 

A fail-safe system should be in place to ensure that normal, abnormal and emergency 

situations that occur at the airfield during finishing can be communicated via the finish line for 

further action by the organisation or other airfield users. 

Where finish rings are being employed (which is now in most competitions), it may not 

always be possible for the Director or designated staff to monitor the actual finish, but they 

should still monitor the field landings to ensure circuits and field landings are carried out in a 

safe and sensible manner. Regular communication with finishing pilots should ensure safe 

landing procedures are carried out. 

Pilots’ Safety Committee (PSC) 

The BGA Competition Rules require that each competition has a three-person Pilots’ Safety 

Committee.   The role of this group is to provide a peer-group forum to promote safety and 

airmanship standards at the competition as well as dealing with complaints arising from 

lapses in those standards without necessarily involving the Organisation. The PSC is elected 

by the pilots in a process set out in section 5.1.4 of the Rules.  

PSC Terms of Reference 

• The PSC is empowered to investigate complaints about safety and/or flying standards 

of all aircraft and pilots involved in the competition, including tugs and tug pilots, but 

may, at their discretion, investigate and take action in the absence of a complaint, 

when they judge that it is necessary to do so. 
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• The PSC has wide discretion in how it deals with issues and complaints but may give 

verbal or written warnings to individuals where they consider it appropriate. This 

would not normally involve the Organisation or be brought to its attention.  

• If, however, the PSC judges that an issue or complaint is particularly serious, or that 

action by the Organisation is required, it may bring the matter to the attention of the 

Director.  In this case, the PSC may recommend that a competition penalty or 

penalties be imposed. Such recommendation may or may not be acted upon by the 

Director.  

• The PSC should not involve itself in any matter other than that related directly to 

Safety and Flying standards. 

• The PSC shall also advise the Director on the awarding of penalties for non-specific 

hazardous/dangerous flying when required. The Director must refer to the PCS, and 

needs their consent, if he/she wishes to apply non-specific hazardous flying penalties. 

Since the PSC is elected at the first briefing, at a time when they, along with the rest of the 

competitors, quite naturally have their mind very much on other things they may not give 

sufficient attention to the matter unless a safety issue actually arises.  Directors are therefore 

requested to make sure that, as early as possible in the competition, they meet with the 

newly elected PSC as a group in a quiet undisturbed location.  At this meeting, the above 

terms of reference should be run through to ensure that all members understand their role.  

Since it is necessary that all pilots and PSC members alike are aware of these Terms of 

Reference, Directors are also advised to publish them to all participating pilots in advance of 

the competition and to display them prominently on a notice board during the competition 

Directors must not regard the penalty that can be recommended by the PSC as one that they 

must administer where no other suitable penalty is available. The penalty that the PSC may 

recommend the Director to award must be as it says - “recommended” - and is intended for 

application in cases where poor airmanship/dangerous flying is displayed to reporting pilots 

despite previous advice from an earlier reported incident. The Director has full and final 

responsibility to decide whether to actually administer the penalty if given a recommendation 

to do so. 
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2.5. Airfield 

As with all airfield operations it is important to establish a safe environment for all people: 

competitors, crews, organizers club members and visitors.  

Airfield Boundary 

The airfield boundary must be made clear to all relevant personnel (landowners and 

members of the public) to ensure that air law requirements will be complied with during the 

competition. The airfield boundary, for the purposes of the competition, must not be changed 

without agreement from the Competition Committee. 

Great care should be exercised in defining the boundary of the airfield taking the following 

key factors into consideration: 

• Legal status 

• Landowners’ permission 

• Airfield insurance cover 

• Public safety (access and H&S) 

• Aviation safety 

Airfield Responsibility 

The airfield operations remain the responsibility of the Chief Flying Instructor during the 

competition, but it is recommended that management control is clarified to all relevant people 

before the competition to prevent any conflicts of interest occurring during the competition. It 

may be necessary for the airfield responsibilities to be delegated to the competition director, 

within set terms of reference, for the duration of the competition. 

If other club operations are occurring at the same time as the competition, the Director must 

ensure that these are co-ordinated in a safe and efficient manner so as to prevent any 

conflict with the safe running of the competition.  

The club should ensure that normal club operations are managed to ensure the safe co-

ordination with the competition.  It is recommended that Director, or a deputy, co-ordinates 

with any instructor who has been delegated the task of running of the normal airfield 

operations during the duration the competition. This should ensure that the safety aspects of 

glider movements during the gridding process are not compromised. 

Local Arrangements with Adjacent Airfields 

Where adjacent airfields may be impacted by the competition the Director should ensure that 

local arrangements are agreed before the competition and, where necessary, communicated 

on a daily basis.  

Airspace Mailing List 

To ensure that airspace is co-ordinated on a daily basis it is recommended that an emailing 

list is established so that daily tasks (printed in the agreed format) are circulated to all 

interested parties as quickly as is practicable. This does not negate the need to follow the 

requirements set by the National Air Traffic Service (NATS). It is recommended that the club 

advertises any additional services that it has implemented locally and nationally to ensure 

that the information can be promulgated to as large a group as is possible. 
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2.6. Airspace 

The pressure on airspace continues to increase, and our freedom to use what remains 

available is under constant threat. It is vital therefore, that we are seen to use the airspace 

with common sense and respect for others. 

The Rules require the appointment of an Airspace Officer. This role should be given the 

highest of prioritisation and support given the reputational risks of misidentification of 

airspace for task setting. A dedicated individual, fully conversant with airspace issues is an 

absolute requirement. 

Whilst there is a requirement to fully brief the pilots on airspace matters prior to competition 

launches, the Competition Director should ideally appoint an Airspace Officer to carry out the 

briefing. Pilots should be reminded that this does not absolve them (according to the ANO) 

from sole responsibility for the conduct of their flight. Where a NOTAM is identified which was 

not briefed, the pilot identifying the matter should report it to the Safety Officer or Director as 

soon as possible and certainly before launch.   

BGA Contact 

Directors should note that there is now a dedicated email address for the BGA Competition 

Airspace Coordinator: - compairspace@gliding.co.uk  

The ACN 

The Airspace Coordination Notice (ACN) is a document issued by the Safety and Airspace 

Regulation Group (SARG) of the CAA. It is created using the information you provided when 

you submitted your competition details to the BGA. It provides detailed information about 

your competition and gives contact information. It is distributed to the BGA Competitions 

Committee, The Competition Director, Military Low-Flying and Air Traffic Control authorities 

as well as to interested parties and airfields in your geographical area about two weeks 

before your event. Read it carefully, it may require the Director to take specific notification 

action. It is also the trigger for the creation of your competition NOTAM, so is a vital 

document. 

Liaison  

You should make every effort to comply with the Coordination Arrangements that are 

specified in the ACN as rapidly as possible. This usually amounts to faxing (or emailing) your 

intended task routes to the military addressees. As this information is used to generate the 

military NOTAMS. The quicker you can get the information out the better. It is difficult to 

provide task routes with the four-hour notice required, but it should be possible to indicate the 

likely task area in that timescale.  

Publishing Tasks to the Gliding Tasks website 

As well as the information sent to the military, it is a requirement that task routes should be 

published to the wider aviation community. This is done by uploading tasks to a website 

which is publicised by NOTAM, and which can be viewed by anyone who may be interested, 

Areas that are likely to have a high concentration of gliders are naturally of interest to other 

users of class G airspace. By being aware of activity, pilots can choose to avoid it.  

file:///C:/Alan's%20Networked%20Folders/Gliding/Comp%20Committee/Rules%20&%20Org%20Guide/Organisers'%20Guide/2017%20Org%20Guide/Draft%20For%202017/compairspace@gliding.co.uk
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The website www.glidingtasks.co.uk  has been setup for this purpose. This website aims to 

show tasks being flown on a particular day that involve many gliders.  

Tasks can be automatically picked up from Soaringspot for competitions using SeeYou for 

task setting and scoring or added manually. See the website for details. Competition 

organisers are asked to ensure that tasks are published on this website as soon as 

practicable on each flying day. 

Please also continue to liaise with any other airspace users who may be affected by your 

flying. 

ATZs 

To enable a successful Gliding Competition required co-ordination with all stakeholders 

including Aerodromes with and ATZ.  The good relationship that Gliding has with General 

Aviation and Airport operators can quickly be destroyed by unauthorised penetrations of 

ATZs. It has not been thought necessary in the past to make ATZ’s penalty areas, since 

penetration in order to land has always been permitted. However, pilots should be reminded 

that penetrating an ATZ without first obtaining permission (or trying to obtain information 

regarding penetration in the case of an airfield without ATC) is illegal and must be avoided. 

Directors are reminded that they can make selected ATZ’s penalty areas if they judge it 

appropriate in their competition, but, in any case, should brief pilots not to make any 

unauthorised penetration of ATZs except for reasons of flight safety. Task-setters should also 

be sensitive to the possibility of ATZ infringements when routing tasks, especially when the 

cruising altitude is likely to be low. 

MATZs 

Military Aerodrome Traffic Zones, not including the central ATZ (IE the 5nm radius zones 

outside the central ATZ together with the associated stubs) have a different status in law to 

that of civil ATZs which, in practice, means that they may legally be penetrated by GA traffic 

without permission. (Note this does NOT apply to the standard 2 or 2.5nm radius ATZ at the 

centre which must be treated as any other ATZ).  

The consequences of many gliders being in potential conflict with fast-moving military traffic 

range from extremely expensive to extremely dangerous or both, so competition organisers 

must take due note of the MATZs in their task areas and consider whether the advantages 

outweigh the risks of tasking through the area.  

If there is clear competition benefit in a task track going through a MATZ, Directors must 
advise the appropriate military contact.  Directors and Task-Setters are reminded that a list of 
military contacts is available on the BGA website at: - 
https://members.gliding.co.uk/library/information-for-organisers/military-flying-unit-contacts/ 
and must ensure that MATZ operators are kept informed of potential glider traffic in or near 
their zones. Pilots too must be briefed to avoid unnecessary incursions. 
 
Radio Calls: - When in the vicinity of a MATZ, as with other areas of sensitive class G 
airspace, pilots are encouraged to make their presence and intentions known by making a 
radio call. Gliders fitted with transponders should turn them on, which makes the use 
compliant with 5.12 of the Rules. Competition organisers will have informed the controlling 
authority of the possible presence of gliders and will brief competitors on whether group or 
individual calls are preferred. In any event, competitors should monitor the MATZ frequency 

http://www.glidingtasks.co.uk/
https://members.gliding.co.uk/library/information-for-organisers/military-flying-unit-contacts/
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when approaching and arrange for those arriving in the area first to call. Later arrivals can 
use their judgement. If in doubt, competitors should call. 
 
Sensitive Areas in Class G Airspace 

There is potential for conflict between gliding and General Aviation arising from glider pilots 

and competition organisers being unaware of the need to liaise with airfield operators in 

certain areas of class G airspace. Busy airfields which have ILS, for instance, have the “ILS-

feathers” marked on the air chart, but these were often disregarded by glider pilots and task-

setters in the past.  Also, GA makes frequent use of Visual Reporting Points. These are 

common waypoints marked on air charts used as routing and reporting aids by GA traffic. 

Certain airfield operators have expressed concern at the number of gliders operating close to 

or within their ILS areas and have suggested that VRPs are best avoided by large groups of 

gliders. The BGA is keen to avoid more demand for controlled airspace from these airfields 

and seeks the help of competition organisers in this.  

Directors and task-setters are requested to be aware of these issues and are asked to take 

these steps to minimize conflict: -  

• Brief pilots on such sensitive areas within the task area. 

• Encourage pilots that when in the area to communicate by radio with the airfield ATC 

concerned and to have their FLARM operating. 

• Brief pilots about any Visual Reporting Points (VRPs) in the task area and the 

potential for GA traffic at these VRPs  Note also that information on VRPs, including 

downloadable files, can be found at Tim Newport-Peace’s website at 

http://www.newportpeace.co.uk/turningpoints.htm 

• Stress the need to maintain a good lookout and preferably a listening watch on the 

relevant airfield frequency. 

• Publish tasks on https://glidingtasks.co.uk,       

• Avoid tasks crossing ILS where practicable. 

If a task is routed close to such an area, make a telephone call to the airfield concerned 

before first launch. You might also want to consider consulting airfields on track where there 

may be a hold pattern to avoid mass routing through an area. Competition Waypoint 

Database 

A special “competition version” of the BGA waypoint database, which excludes turn-points 

close to sensitive airspace (which it would be unwise to use in a competition) is available on 

Tim Newport-Peace’s website:- http://www.newportpeace.co.uk/waypoints/competition.zip . It 

is recommended that only these waypoints are used when setting competition tasks 

Controlled and Prohibited Airspace 

Task setters should not set task lines through prohibited airspace (this includes Class ‘A’ 

controlled airspace) unless the lower ceiling for that airspace is higher than 3500’ alt. 

Additionally, consideration should be given to not setting task lines very near to any low 

airspace where the prevailing wind is likely to drift a pilot into it if soaring conditions become 

unexpectedly difficult. Note that specific exemptions may be implemented for particular 

gliding competitions, such as the Compton Box section of Class ‘A’ airspace in the LTMA. 

Gliders are excluded from Class ‘D’ airspace in competitions unless special provision has 

been made i.e. block exemption from the controlling authority. Otherwise, all Class ‘D’ 

http://www.newportpeace.co.uk/turningpoints.htm
https://glidingtasks.co.uk/
http://www.newportpeace.co.uk/waypoints/competition.zip
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airspace should be considered as inaccessible to competitors during the competition as there 

is a possibility that whilst one competitor will be granted clearance to cross, another may not. 

In order therefore, to maintain fairness, no competitor should fly within Class ‘D’ airspace. 

Transponders 

Now that transponders are required for flight above FL100 except when the requirements to 

use “gliding sectors” can be met, BGA rules now define flight above FL100 as into forbidden 

airspace except where the requirements of use of “gliding sectors” are met without the need 

for a transponder. Where tasks are set near to these upper level “gliding sectors”, pilots 

should be carefully briefed on this matter. 

RA (T)s 

Lessons learnt from the mass RA (T) infringement at Silverstone in 2010 indicated that, even 

if there had been no infringement of the airspace by competing gliders, it is quite likely that 

the display would have been curtailed simply due to the risk associated of having so many 

uncontrolled aircraft so close to the display line in use. Therefore, it is vital that any task is 

set a reasonable distance clear of any RA (T) during its active time phase – that should 

include the track line associated with starting from the very extreme end of the start line and 

should allow for a degree of track error and the likely influence of the wind direction if soaring 

conditions become unexpectedly difficult. 

Where an active RA(T) is very close to the event take off point and start point, serious 

consideration should be given to not launching during that time period. It is possible that such 

action might lose a contest day in extreme circumstances – however, as a repeat of the 

Silverstone incident would have such serious repercussions for all UK glider pilots, this 

should be regarded in extreme circumstances as a reasonable course of action. 

Star-D (*D) Danger Areas 

“Star-D” (*D) danger areas are special danger areas which contain airspace subject to 

bylaws which are in force when the danger area is active.  For this reason, unlike other 

danger areas, all *D areas are permanent penalty areas (Rule 5.10.3).  Where a *D danger 

area also has the § character prefix (e.g. §*D208) this means that periods of activity may be 

determined by contacting a nominated authority.  If it is established by the competition 

organiser that the area will not be active, it may be briefed as inactive and annotated as such 

on task sheets. Otherwise, it will still be a penalty area.  Note, however, that other restrictions 

may still apply and would have to be briefed, (for example, landings are still not permitted in 

§*D208 even when it is not active, so extreme caution is advised before doing so.) 

Nuclear Sites Restricted Area Exemptions 

An exemption may be available (see *Note below) to allow gliders to fly inside the restricted 

areas R101 (Aldermaston) R104 (Burghfield), subject to the following conditions in addition 

to normal air law: 

1. Each site’s dispensation must be separately activated by the competition director by 
contacting the nominated authority for each individual site and must have been 
briefed as effective on the day. 

2. Gliders must not fly within the areas bounded by the fences or in such a manner as to 
cause a landing or crash inside the fenced area in the event of an accident. 

3. This dispensation only applies to gliders with a glide angle of 30:1 or higher. 
4. The installations must not be photographed. 
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Rule 3 above suggests that the authorities do not want gliders landing inside the areas, even 
outside the fences and, in the interests of the continuation of this concession, it is strongly 
advised that pilots should avoid putting themselves in this position.  However, it is better to 
land safely inside the circle rather than crash just outside it. 
 
* Note: - This exemption is reviewed annually. Its availability, or otherwise, will be 
communicated to competition organisers. You should not assume availability unless you 
have received confirmation that the exemption has been granted for the current year. 

2.7. Penalties 

The penalties associated with airspace infringement are simple and severe. This is to further 

discourage the infringements that regrettably still occur – further details are posted in the 

“penalty” section of this publication. 

2.8. Task-Setting 

Task setting is all about planning the task length and shape to optimise the opportunities on 

a given day. In the United Kingdom, with its myriad airspace arrangements, challenging 

weather conditions and sometimes short soaring ‘windows’, the role of the task setter should 

not be underestimated. 

Getting the right balance for the appropriate task needs to consider pilot ability, range of 

glider handicaps (where applicable) and airspace density and timings.  The seriousness of 

potential airspace infringements, from a reputational perspective, should be considered at all 

times when designing tasks on any particular day. 

A good task should give all competitors a fair race with a minimum of luck and guesswork.  

Whilst it is undesirable to ‘waste’ a good day by under-setting the task, you should also 

attempt not to over-set - making it impossible for competitors to finish. This is particularly true 

when it only affects the pilots flying lower performance aircraft. 

Attempting to set tasks to generate a 1000-point day only for the day to become ‘devalued’ is 

misguided. If the weather conditions dictate a short task length of 150km, then this is what 

should be set.  It would be better for all concerned if a shorter task is chosen, thus allowing 

the pilot some flexibility on start time, and still race in reasonable conditions using most of the 

available day. Please bear in mind that you’re unlikely to get disgruntled Regional’s pilots’ 

who complete a fast 300km, but you will if they fail a struggling 400km!  

With that in mind, tasks should be designed not to maximise the distance flown on a 

particular day but to establish, by the end of the competition, that the winner is the fastest 

pilot.   However, where soaring and a successful grid launch can be guaranteed by mid to 

late morning, a longer task should not be ruled out.  

The key to setting a good task is to establish what the meteorology information suggests is 

the ‘rough area’ where the task should be best set and what the ‘length’ of the soaring day is.  

This should be done at the earliest opportunity on a particular day, although options may be 

forming 24-48 hours before. 

The next action is to decide what type of task is required.  There are two long-established 

course types:  Fixed Course and Assigned Area. In 2014 a new type of task was introduced 
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which was originally felt appropriate for Regional competitions and the Junior Championships 

only but may be considered for all competitions.  This new task type, known as “Distance 

Handicapped” uses a turn-point barrel radius that increases as the glider handicap reduces 

in such a way that every finisher will have flown the same handicapped (and windicapped) 

distance. See the article on this task type in section 2.7. 

The definitive rules for all task types can be found in section 5.7 of the Rulebook.  

Assigned Area tasks are intended to allow competitors the opportunity to make the best use 

of soaring conditions and should be set only when good uniform soaring conditions are 

forecast across the whole task area to avoid the results being unduly influenced by luck. 

However if the Director/Task Setter is/are unsure of the weather, the aim is not just to fall 

back to an AAT as a fail-safe due to indecision..!   

The AAT task is a valuable test of skill for pilots in uniform conditions, but care should be 

taken to ensure that the design is carefully thought out and limits the degree of chance that 

can be created with the setting of this type of task. AATs can be a good option when there is 

a large variation in glider handicaps and can also make a welcome change from fixed course 

tasks.   

In general, where conditions are unlikely to be uniform, a fixed course or Distance 

Handicapped task should be set 

Some pointers for setting the task are as follows (bearing in mind that with large multiple 

classes you will need separate start points/lines): 

a) Check the met forecast and discuss this with your ‘Met man’ at the earliest 

opportunity.  

 

Decide the rough area where the task should be set and also the best finish direction 

given forecasted wind.  At this point you may have decided what type of task 

(AAT/Fixed Course/Distance Handicapped) is appropriate.    

b) Establish the Permanent and Temporary Airspace that will impact on the task. 

 

In most cases the airspace identified the night before may have not significantly 

changed but re-confirm what temporary airspace may impact the task before starting 

task planning.  Where a significant temporary airspace is present, such as a RA(T), 

then it may mean compromising the task to an area where the weather is not as 

good. 

c) Decide when the start line is likely to open.   

 

This will be approximately an hour after the first launch.  First launch depends on how 

the day develops but may be delayed by the requirement for briefings, getting 

everyone on the grid, and the inevitable other delays that may occur due to weather. 

On the first flying day of a competition there are the additional risks of delays due to 

pilots being unready and also potential organisational issues such as grid launching. 

d) Decide when the pilots need to finish by.   
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Does the met man envisage the day continuing into the evening or shutting down 

early for any reason?  Is any weather arriving to spoil the day?  This, of course, 

comes with experience but where thermal strengths are likely to deteriorate due to 

top cover approaching from a warm front then it useful to consider this issue, in 

combination, with any significant head wind that might impede progress on the later 

stages of the task. 

e) Estimate the achievable XC speed taking into account glider and pilot performance. 

 

This will be based on thermal strength and cloud base but must also allow for positive 

factors such as streeting and negative factors such as spread out.  

 

The combination of available task time and predicted XC speed gives an estimate for 

the potential task distances achievable.  For fixed course tasks, this calculation 

should be based on the slower pilots in the lower performance aircraft.   

f) With AATs and Distance Handicapped tasks, lower handicappers will not be required 

to fly the same distances as the high-handicappers, and this can be taken into 

account. 

g) Decide Distances and Task Shape 

 

From your rough estimation of achievable task distance you should be able to design 

a task within your task setting programme that can be shaped to coincide with the 

area where the best weather is likely to be available.   

 

The available task area and the desired task length will influence the overall task 

shape and whether the task has to be folded to fit (creating ‘arrow’ or ‘bowtie’ shaped 

tasks).  If the wind is strong then consider predominantly up and down wind.  Running 

streets is fun but struggling crosswind can be demoralising.  Inbound and outbound 

tracks at turning points should be separated where possible as lookout may be 

compromised close to turning points. The angle between the two should, wherever 

possible, be not less than 30%. 

 

Excessive numbers of turning points should be avoided although it will sometimes be 

necessary to add control points to ensure adequate clearance from airspace. Don’t 

make the mistake of trying to use standard turn-point types as control points in an 

AAT. All zones in an AAT, however small, will be scored as areas (IE the distance 

flown inside them will count) so even control points must be flown as such. You may 

want to emphasise this point during briefing. 

 

In general, when setting  Fixed Course tasks or Distance Handicapped tasks, 2 or 3 

turning points will be adequate unless weather and airspace require additional control 

points to ‘fold’ the task into the available soarable window. 

 

Take particular care to avoid setting task legs close to very low airspace where the 

prevailing wind may encourage pilots to get pinned against the airspace boundary 

when conditions are unexpectedly poor thus encouraging accidental infringements. 
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Fall-Back Tasks 

Several fall-back tasks should also be set just in case the day does not develop quite as 

predicted.  It is preferred that this is done without significantly changing the shape of the task 

by using turning points that are close to the original task line. When using this approach be 

careful that this does not result in task lines becoming closer to ATZ and Parachute Drop 

Zones. 

To minimise planning and pilot stress it is often possible to do this by changing or removing 

one turning point of the original task at a time.  This approach can also minimise the work 

involved when multiple classes are being tasked simultaneously as fall-back tasks for one 

group can become primary tasks for another. 

It is recommended that fall-back Fixed Course or Distance Handicapped tasks are set that 

are incrementally reduced in length to take into account of delays in launching the grid.  

Every ½ hour delay, from primary task ‘window’ is approximately equivalent to 30-50kms of 

task length.  This can be done similarly for AATs but reducing the time on task by ½ hour 

increments.  

When considering fall-back options for Distance Handicapped Tasks, it may be tempting to 

ask pilots to simply drop down a few handicap places rather than issue a new task. While 

adequate for club use of this task type, this is not acceptable in a rated competition as it will 

introduce additional approximation errors and scoring will be unreliable. 

Enhanced Option “Showery” Turn-point 

If showers are considered more than likely you should use the enhanced turning point option 

in your Fixed Course or Distance Handicapped task. The “enhanced option” turn-point design 

has the normal 90 degree 20km sector behind the 0.5km radius extended to 180 degrees but 

reduced in radius to 10km. This effectively creates a huge opportunity to gain control at a TP 

and gives a viable alternative to entering the 500m radius of the conventional TP in showery 

conditions. Please note that, in fixed-course tasks, the 500m radius still exists in this new 

format and flying to these will always represent the shortest task length, even if the 180° 

sectors overlap. In DHT’s, the barrel size is as briefed. 

When using this type of TP no benefit is accrued for any extra distance flown as it would be 

in an AAT. A task set with Enhanced Option turn points replaces the alternative TP tasks that 

used to be set in showery conditions before AATs became available and then subsequently 

used by default. It is intended that tasks with enhanced option TPs are used for flights where 

organised showers are forecast. It is recommended that normal TPs are used when shower 

activity is forecast to be occasional only. 

SeeYou and Task Sheet 

By this stage, the task setter has defined the task area, the task length and the finish 

direction.  It is time to fire up a task setting program and start creating the task sheet.  It is 

important that SeeYou is set up before the competition begins with current airspace 

information and the current competition turning-point list.  It may be useful to add templates 

for different task types, turning point types and finish line directions.  This makes the design 

of the task on a particular day relatively straightforward and takes away the potential for 

introducing errors. 
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It is also advisable to add any temporary airspace for the day.  This will enable tasks to be 

set more readily with reasonable separation of turning points and track lines from airspace 

boundaries. 

Once the primary and fall-back tasks have been selected, it is important that they are 

reviewed by someone who has not been involved in the task setting process.  This provides 

a sanity check and should especially check for any problems with airspace.  The Director 

may wish to do this. 

The format for the task sheet is now set out in the Competition Rules and an example of the 

required output is provided in Part 4 of this document including some guidance on how to 

create them in SeeYou. 

It is important that the information provided on the task sheet is accurate and in the format 

required by the BGA.  In particular the following points should be checked: 

• Task designation is explicitly clear. 

• Turning point tri-graphs and co-ordinates are provided as per the format in BGA 

turning point list. 

• The observational style description is included (see example).  It is not recommended 

to attempt to provide additional information on bisector angles that are not 

automatically calculated by SeeYou. 

• All temporary airspace, and ATZ information, is laid out as required by the BGA rules. 

By creating a standard format task sheet, it is hoped that the much-heard pilot question of “Is 

it a penalty zone?” will become one from the past! 

In most cases the Task Sheet can be on one piece of A4 paper, but where additional tasks 

are required, this may require additional task sheets to be produced.   Note that with 

Distance Handicapped tasks, a separate sheet with barrel sizes for each handicap will 

probably be required in any case.  

Where there is any doubt on the weather, and task shape/length, it is best to delay briefing 

until the most appropriate task can be configured.  Attempting to rush a task to meet a 

briefing deadline could ultimately end up in the best task for the day being missed or, worse 

still, the day being scrubbed. 

A template task sheet should be prepared in advance that can be used daily to check the 

task sheets prior to photocopying. Include a checklist to ensure that all details are updated 

with the day’s relevant information and check that details have not been inadvertently copied 

from the previous day. 

As the day develops, the task setter, in dialogue with the Director and Met-Man, should 

review the tasks and select the appropriate one for the conditions. This may be the primary 

task, one of the fall-back tasks or a totally different task which is subject to a briefing at the 

front of the grid. Briefing on a new task at the front of the grid brings on a number of other 

challenges, and risks that should be carefully thought through before taking forward. 

At the end of the day, it is useful to the task setter to discuss the day’s task with the pilots so 

that lessons can be learned for the rest of the competition. 
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2.9 Distance Handicapped Tasks 

In 2014, a new type of task format for handicapped competitions was made available for trial, 

initially for use in Regionals and the Junior Championships.   During 2014 and 2015 the new 

format was used in several regional competitions and proved very popular. Use of DHTs 

should now be considered usable for all UK competitions. Distance Handicapped tasks 

(DHTs) are similar to standard fixed-course tasks in that all gliders fly to the same turn-

points. The difference is that the radius of the turn-point barrel (or “beer-can” as it is 

sometimes known) increases as glider handicap decreases.  Lower handicap gliders turn 

earlier than high handicappers, so fly a shorter task. The barrel-sizes are calculated such 

that, if everyone turns at the optimum point on the circumference of their barrel, all finishers 

fly the same handicapped (and windicapped) distance.  

This task format has several advantages over the standard fixed course task: 

• Other things being equal, the time on task should be the same for all gliders, so 
low-performance gliders don’t have to set off early and finish late. This negates 
the disadvantage they usually suffer through having to use the poorer conditions 
at the beginning and end of the day. 

• Shortest time on task wins, so if start times are accurate, day ranking becomes 
obvious as soon as finishers arrive. 

• Low handicappers can stay “in touch” with high handicappers throughout the race, 
making it more fun for everyone. 

• It is suitable for task groups with a large handicap range 
 

There are also some disadvantages: 

• Windicapping affects barrel-size, so these tasks have to be set and scored using 
a forecast contest wind, not one inferred afterwards from traces.  Wind forecasts 
tend to be fairly accurate, so this is not expected to be a serious problem.  

• Accurate turn-point capture in the air is difficult without using some form of GPS 
navigation device, since, for most competitors there is unlikely to be a distinct 
ground feature close enough to their target point on the barrel boundary.  GPS 
navigation devices are in universal use in competitions these days, so this is not 
seen as a significant problem. 

• These tasks are not suitable for helping pilots of low-handicap gliders gain badge 
flights during a competition since they will not be turning close enough to declared 
turnpoints.  This is hardly a problem, but directors should be aware of it.  

 

The Software 

Each individual handicap requires its own turn-point barrel radius to be calculated and each 

is dependent on task length and wind-strength.  This type of task has only become a 

practical option for rated competitions due to the availability of special software. The software 

works alongside SeeYou to offer organisers the means to set and score tasks of this kind 

with very little impact on the processes already in place for the traditional task types. The 

Software is free and can be downloaded from  

http://www.handicaptask.uk/ 

There are two modules, one for task-setting and one for scoring. Both have comprehensive 

on-screen help and are easy to use. Note that the software is designed to work with SeeYou 
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and SeeYou Competition, but the version of SeeYou in use must be 5.44 or higher for all 

features to work reliably.  Naviter, the owner of SeeYou kindly makes temporary licences 

available to competitions free on request, so this should not be a problem. 

Competition organisers wishing to make use of these tasks are advised to download the 

software and familiarise themselves with it as soon as possible.  To help with training, the 

software developers have published a set of videos. These are to be found in the videos 

section of the Boffins website 

Settings 

The software is designed to support both BGA rated and informal club competitions.  When 

used in BGA rated competitions, the following settings should be used. (NB the following is 

correct for V 2.4.2.0 of the Handicap Task Calculator program. Future versions may change) 

Program Options, Defaults tab 

Check the box marked “BGA Competition Defaults”. 

Note that it is now possible to set “Showery Turn-points” in DHT’s. Selecting the 90° Sector 

Angle of the Variable TP Shape will automatically change the radius to 10km 

Set Checkpoint shape/size as desired, but make sure this is correctly depicted on the 

SeeYou Task Sheet. 

Setting Tips for Distance Handicapped Tasks 

Track lines and actual turning points can be significant distances apart for gliders of widely 

different handicaps, so task-setters need to take special care to ensure that gliders at one 

extreme of the handicap range are not disadvantaged by having to negotiate airspace that 

gliders at the other end of the range won’t encounter.  For more detailed advice on this topic, 

read Tim Scott’s excellent article on the subject published in the April/May 2016 issue of 

Sailplane and Gliding and reproduced on the BGA website at 

https://members.gliding.co.uk/library/information-for-organisers/handicap-distance-tasks/ 

Minimum Barrel Size 

The default minimum barrel size for DHTs used in BGA rated competitions is 0.5km. This is 

appropriate where the range of handicaps is wide, to keep the maximum barrel-size down to 

a reasonable level. However, where the handicap range in a competition is narrow enough to 

allow it, the minimum barrel-size can and should be set larger than 0.5km. This will have the 

effect of improving fairness by increasing the size of the target for the high handicappers. It is 

also an alternative to the use of “Showery” turn-points when showery conditions raise the 

possibility of a TP being obliterated by weather. The latest version of the DHT software will 

allow this even when “BGA Competition Defaults” is checked. Earlier versions will need to 

have “BGA Competitions Defaults” unchecked, in which case the other standard BGA 

parameter values will have to be selected. 

Briefing The Tasks 

Since this is still a new task format, not all pilots will be familiar with it.  It is imperative that all 

pilots should be thoroughly briefed. The concept is relatively simple and should not present 

too many problems for pilots, but the format does imply a change of tactics and, for the sake 

of fair play, pilots should be given the time to think through the implications and to ask 

questions.  Don’t spring it on them on day one.  Ideally pre-announce your intention to use 

https://members.gliding.co.uk/library/information-for-organisers/handicap-distance-tasks/
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this type of task in the Local Rules and, if you plan to set one on day one, try to lay on a 

briefing session on the previous evening.  It needn’t be lengthy, but the following points must 

be made clear to all pilots: 

• Your barrel size is fixed and unique to your handicap, for all but control points, in 
each task. 

• Every new task, including alternates on the same day, will mean a different barrel-
size for you.   

• Make sure you know your barrel-size and the radius of any control points for the task 
you will be flying before you launch.   

 

A feature of these tasks is that, apart from control points, all turn-point barrels for a given 

handicap on a given task are the same size and are circular.  This means that they can be 

flown by pilots with the bare minimum of navigation avionics. A hand-held GPS would do. 

Pilots can, of course, set up their moving map instruments with the exact observation zone 

geometry, but those without the equipment or the skill can simply monitor their distance from 

the nominated TP and turn once it indicates they are inside the barrel. This may be obvious, 

but it should be pointed out at briefing. 

Alternate and Fallback Tasks 

Barrel sizes are unique to each task. Directors must ensure that the standard Task sheet as 

specified in the Rules, together with the task reports from the special software (which shows 

the task turn-points and the list of handicaps and barrel-sizes) are attached to each other 

when distributed to pilots, or better still, printed on two sides of the same sheet.  Alternate 

tasks and Fallbacks can be very similar to each other, so Directors are also advised to 

include an independent check of all briefing documents before distribution to ensure that the 

correct barrel-sizes are always attached to the task sheet.  A task flown by the whole field 

with the wrong barrel-sizes would be almost impossible to score fairly, resulting in a non-

comp day if it were to happen.  

While creating fall-back  tasks in Distance Handicapped tasks by asking pilots simply to drop 

a few handicap places may be fine for club use of this type of task, it is not acceptable in a 

rated competition. Separate fall-back tasks should always be used. 

Task Sheets 

Although it is possible to create individual task sheets for each handicap with the correct 

barrel-size shown on the map, this is obviously impractical in a competition.  It is 

recommended that the task map shown on the SeeYou task sheet should be created using a 

standard barrel size of 5km (or the maximum barrel-size if less than 5km). This should make 

it easier for everyone to estimate the size of their own barrel. The sector associated with the 

barrel, which will be of more relevance to the higher handicappers will then always be visible. 

2.10. Daily Briefing 

The daily briefing and the use of task sheets is the only way of ensuring that the pilots have 

the correct information for the task that they fly. The organisation of the task, bringing 

together task design, airspace co-ordination and meteorology information should not be 

spoilt by a poorly provided brief and task sheet. 
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Pilots are reliant on that information being correct not only to provide a valid flight but to 

ensure that flight safety is not compromised. 

Critically important is the requirement to brief Airspace restrictions, exemptions and hazards 

that might affect competitors. The minimum content of airspace briefings is specified in 

section 5.2.2 of the Rules and calls for the following information to be provided in graphical 

format:  

• Local Airspace Hazards 

• LOAs & Associated Procedures 

• Parachute Zones 

• RA(T)s 

• NOTAMs 

• Other Additional Penalty areas. 

Section 5.2.3 of the Rules identifies the minimum content for task briefings and task sheets. 

See the reference section for detail on the creation of task-sheets. 

Where an additional airspace restriction is in force and hence briefed and there is a 

possibility that tasking could take a pilot close to such airspace, the organisation should 

provide sufficient detail to allow pilots to create electronic files for their navigational 

instruments. You should consider providing this detail where known at the beginning of the 

competition. If this is not possible and the additional airspace design is not a simple circle, 

tasks should not be set where there is any realistic likelihood that such additional airspace 

may be infringed.  

Pilots entering a BGA rated event should be fully conversant with the normal airspace in the 

task area as published and in force all the time as described on a current ½ million aviation 

map. It is always helpful to amplify this knowledge by verbally briefing the various standard 

airspace considerations in the area likely to be flown in on each of the designated tasks. 

However, contest organisers have a duty of care and must fully advise pilots giving 

appropriate detail of any additional prohibited airspace notified by NOTAM that may be 

encountered on task. It is not realistically possible in a contest situation for the pilots to check 

all NOTAMs themselves. They are rightly reliant on the organisation for a full and 

unambiguous briefing of temporary additional restricted or prohibited airspace that may be 

relevant to the intended flight. 

See the reference section for details of minimum content for task sheets. 

2.11. Met Briefing 

Met forecasting is essential for task-setting. However, it is also essential information for pilots 

if they are to make the best of the day. 

Minimum weather information such as wind speed and direction, cloud base, thermal 

strength and expected cut-off time etc. should always be provided at morning briefings.  

Best-practice, however, recognises that a pilot who has a good grasp of the synoptic 

situation is better-equipped to make tactical decisions when faced with changing weather in 

the task-area and this is one of the key skills that separate champions from also-rans. For 

this reason, organisers should make every effort to lay-on as high a standard of met briefing 

for the pilots as they are able. 
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A qualified aviation meteorologist on the team is, of course, the gold-standard. However, with 

the excellent met information available on the internet nowadays, it is not at all necessary to 

have a meteorologist (amateur or otherwise) on-hand to be able to deliver a high-standard of 

met briefing.   

Many pilots are quite capable of self-briefing to an acceptable standard using these modern 

tools and this will be true of many of your competitors, but it is often difficult to do this 

effectively in a competition environment, so a briefing to at least the same standard should 

be given.   

As a minimum, the organisation should seek to prepare a short presentation each day 

containing the information that such a self-briefing pilot would normally use. 

Here are some commonly used internet sources: 

The Met Office    

http://www.metoffice.gov.uk/ This is a free general service 

http://www.metoffice.gov.uk/aviation/ga     This is the Aviation service and is free to 

registered users. Registration is free.        

Rasp  

http://rasp-uk.uk/ This is a free service 

Top Meteo & Skysight  

http://www.topmeteo.eu 

https://skysight.io/ 

 

These are subscription services. 

 

 

 

 

 

 

 

Gliding-Club Forecasters from their respective websites: 

http://www.lashamweather.co.uk 

http://www.londonglidingclub.co.uk/forecast.xml 

http://bggc.co.uk/members/weather/sids-weather/    

   

2.12. General Communications 

Good communication with everyone at your competition is essential. Competitive fairness 

goes out of the window the moment any pilot fails to receive information that he or she needs 

for the competition and everyone’s enjoyment is threatened when stress-levels go up due to 

poor communication.   

The trick here is belt and braces. Never rely on a single medium for delivering a message.  

Key Competition Communications: 

• Grid Order:   Handed out at initial briefing and Posted on Notice Boards 

• Grid Before Briefing: On Main Notice Board, On website, By Text Message 

• Briefing Time:  Nominal daily briefing time in Local Rules  

with changes advised by Notice Board, on Website, by Text 

• Earliest 1st Launch Announced at briefing. Changes on PA, Competition     

http://www.metoffice.gov.uk/
http://www.metoffice.gov.uk/aviation/ga
http://www.topmeteo.eu/
https://skysight.io/
http://www.lashamweather.co.uk/
http://www.londonglidingclub.co.uk/forecast.xml
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Frequency Airband, Text Message. 

• Rebrief   Announce on PA, Airband, Text Message 

 

2.13. Competition Radio 

Radio Communications can largely be split into 3 areas: organisation, competitor/crews, and 

other airfield users. 

To ensure efficient transmission of communication to all key organisational staff, it is 

recommended that ground to ground and ground to air radios are used. Where possible, 

separate frequencies/channels should be established to ensure that clarity is maintained in 

normal, abnormal and emergency operations. 

Radio channels for communication with tugs, competitors, and other airfield-based gliders 

should be established beforehand so that conflicts with other competitions and other gliding 

operations are avoided and so that key safety messages can be communicated to all 

relevant aircraft expeditiously. 

 

2.14 Misuse of Radio and Digital Communications Enforcement Guidelines 

Introduced in 2019 a new communications section of the rules was introduced with the 

following two linked objectives: 

1. To preserve the spirit of fair competition between pilots without external assistance 

2. To minimise distraction, with all its safety implications, from the increasing availability of 

in-cockpit Internet and messaging services on mobile devices. 

Ground crews providing a pilot with tactical data by radio or other means is now banned as is 

the use of any external data in the cockpit other than collision avoidance and SPOT (or 

similar) trackers.  

It had been argued that no attempt should be made to ban such things, simply because 

policing and enforcement would be difficult. The Comps Committee does not agree. The new 

radio rules present no greater policing problem that in the past. (It has been against the rules 

for many years, for instance, to use unauthorised frequencies and the rulebook already 

contains other rules that are difficult to police (cloud flying within 10km of a turn-point, for 

instance), but they are rules nonetheless and pilots know where they stand.  

There’s no denying that a ban on mobile devices and in-cockpit internet could make life quite 

difficult for organisers if we tried to introduce heavy-handed enforcement but we believe that 

most pilots will comply with a rule if they know it exists. 

We suggest that directors adopt a light-touch approach on this. The following measures are 

recommended: 

• Detailed briefings to make it quite clear what is allowed and what is not. 

• Directors may feel that asking each pilot to sign a declaration that he/she is aware of 

the new rules would be of value  

• Occasional random equipment checks may be used to reinforce the rules. 
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Penalties have been revised to deal with any cases where these rules are broken, with first 

offences now attracting 250 penalty points. Obviously, penalties should only be given when 

there is strong evidence that the rules have indeed been broken.  

If the rules are being broken, we expect that it will eventually become evident and peer 

pressure will play a large part in keeping people honest. The Pilots’ Safety Committee has an 

obvious role to play here. 

Obtaining tactical data from outside sources that are not available to all competitors is unfair 

and using mobile devices is unsafe. We believe that most pilots will welcome these changes. 

The few who don’t, and cheat may be able to get away with it for a while because of the 

difficulty of detection, but they will be taking a big risk and they should know it.  

2.15. Gridding 

The Purpose of Forming a Grid 

To minimise the role of chance in the competition, it is important that the entire field should 

be launched within the minimum time and that launching should start exactly when the 

Director intends and be completed as quickly as possible. It is also important that gliders are 

launched in the order required by the rules. Mustering the gliders together in a grid at the 

launch point makes all of this possible. 

Grid Order  

Grid order determines launch order. Pilots must be informed well in advance what their grid 

order for the day is. The usual practice is to allocate gliders to a “Cone Number” and move 

the numbered cones, marking the position of each row from day to day. The glider always 

aligns with the same cone number. This lets the grid form automatically in the right place and 

in the right order without help from the marshals once the cones have been set out. 

The Shape of the Grid 

The shape of the grid (how many rows and columns) will be determined to some extent by 

size of the airfield and the launch area. However you do it, leave access lanes between 

columns to allow later-arrivals to reach their allocated row and to allow pilots who refuse a 

launch (before the grid is compressed) to extract their glider and get to the back of the grid or 

the designated relight area.  

Heavy Column  

If you have a mixed-class field containing some large gliders and only a few powerful tugs, 

consider designating one of the columns for the heavies. That should help spread them out 

through the launch sequence and, with luck, you will always have a heavy glider available 

when your powerful tugs arrive. 

Class Grid Order  

Usually the grid is split into a number of separate task groups or classes. Grid order for each 

task group should be rotated as a principle daily to equalise priority where possible. 

Sometimes, however, it is necessary to put the “heavy” class at the back for safety reasons 

when the runway length, ground conditions and lack of wind mean it is unsafe to do any 

other. However, this should not become the default position and every effort should be made 

to share priority amongst the classes when safe to do so. This might be achieved by 

prioritising “heavy” classes when the wind strength and direction allow rather than rotating for 
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the sake of rotating given that the conditions may well not allow heavy gliders launching from 

the front on subsequent light wind days.   

Grid Before Briefing 

On good days, you will want to launch as early as conditions allow. In this case the cone 

system, coupled with access lanes, really comes into its own, letting the pilot’s grid any time 

before briefing. It is essential that GBB is communicated to pilots as early in the day as 

possible. The competition notice board, the website and text messaging are ideal for this. An 

announcement on the PA system should also be considered at breakfast time. 

Grid Marshals 

 It takes a lot of effort to get a large number of gliders assembled at their appointed places 

and launched without delay. The launch rate with a large grid can be intense and a team of 

people who know what they are doing is essential if this is to be accomplished. It is good 

practice to have grid marshals identifiable using high-visibility vests. This lets everyone else 

know who they are and lets them spot each other amid the throng of crews and onlookers. It 

does not take many good grid marshals to run an efficient grid. The key is that they should 

work as a team under the direction of a single individual. 

Equipment 

Not much is needed, but a few short ropes with rings for release-checks are essential as are 

rope-hooks. With rope hooks, two marshals working together can bring the rings from a 

waiting tug to the nose of a glider ten times faster than a single person on their own can do it. 

Shaving seconds off each launch is as valuable as fast-climbing tugs when it comes to 

getting a large grid launched in under the hour. 

Self-Launchers  

Self-launchers can usually be incorporated into the grid and allowed to launch direct from 

their grid position. If you are short of runway, however, and your launch area permits it, you 

might want to consider sending heavy self-launchers off (in proper order) from an area off 

grid, and as far back as possible. This approach might also be considered if self-launcher 

slipstream is a concern. 

Compressing the Grid 

On all but the largest of airfields you may want to maximise the available length of take-off 

run. This can be achieved by compressing the grid from front to back shortly before the 

launching commences.  Cars and equipment should be moved out of the way and gliders 

rolled back so they are nose to tail. Note that once this is done, any late arrivals on the grid 

will have lost their opportunity to take their place and will have to be treated as if they have 

refused a launch. Also, any pilots wishing to refuse a launch will be unable to get out of the 

grid and moving them out during the launch sequence could be disruptive, so compressing 

the grid should be left as late as possible. 

Managing “Grid Squats”  

If the weather does not cooperate, an opportunity to launch may not occur until later in the 

day or, even, not at all. This could mean waiting on the grid for an extended period. If 

launching is to be delayed, it is imperative that pilots are kept informed. The time for the 

earliest possible first launch should be kept under constant review and communicated to the 

pilots. Announced slippages should be long enough to be worth announcing but not so long 

as to run the risk of missing a favourable opportunity. Once announced, a slippage must not 
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be revoked and whatever happens, pilots must not be put in the position of being rushed into 

an unexpected launch.  Good practise is to keep to announced times and to give ten and five 

minute warnings. A portable PA system for use on the grid can be invaluable here. 

Announcements should be backed up on air band as many pilots will be close to their gliders 

with their radios switched on. Announcements of new earliest launch times should also be 

made on the public PA system in the communal areas. 

If the grid-squat has been going on for an extended period, consideration should be given to 

standing down for comfort breaks and/or lunch.  

2.16. The Decision to Launch 

When conditions are good, you can’t go far wrong launching as soon as it becomes soarable. 

During the time between first take-off and opening the start line, conditions are likely to have 

improved and getting the start line open as early as possible will probably be sensible. In any 

case pilots always have the option of making a later start if they wish. 

When conditions are marginal or rapidly changing, launching too soon could result in mass 

relights, but launching too late could mean missing a useable window.     

Competition pilots will generally trust the Director’s decision to attempt the task, so the 

Director has a responsibility not to launch until there is a reasonable prospect of completing 

it. Likewise, the Director has a duty not to launch if weather conditions are, or are likely to 

become, hazardous. Where conditions are marginal and you have multiple classes consider 

not stream launching for safety reasons, i.e. cloud base not going up lots of gliders in vicinity 

of the start low.     

The Sniffer 

On any day, the sniffer is the Director’s first opportunity to find out whether conditions are 

developing as expected. A good sniffer can be an invaluable aid to the Director in making the 

decision to launch.  

Make sure the sniffer pilot understands what is required, i.e. clear factual reports of the 

conditions (achieved average climb rate, cloud base, visibility, wind at flying heights). Over-

enthusiastic reports and personal opinions are not wanted. 

In difficult or rapidly changing conditions a turbo-equipped glider can be particularly useful as 

a sniffer.  If you have a choice, a sniffer with wing-loading similar to the competing gliders is 

also beneficial. 

Re-briefing  

If conditions dictate, it may become necessary to switch to a fall-back task.  If this is one 

which was briefed earlier as one of a set of alternatives, the briefing should consist simply of 

informing pilots of the change and ensuring that all pilots are aware by using a re-brief 

checklist at least 15 minutes before launch.  On the other hand, if a completely new task is to 

be briefed, extra care should be taken.  The new task will have been created in response to 

unexpected conditions and it may well have been created in a hurry.  Extra care must be 

taken to ensure that the new task meets the required standards and that proper task sheets 

are produced.  The rules require a minimum of 30 minutes before launch in this case. 
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It is general practise to call the pilots together in a group on the grid to carry out these re-

briefings.  It is then easier to ensure that all pilots have the information, but it also promotes 

fairness since it allows clarifications and answers to questions to be heard by all.  As well as 

the new task, pilots should also be told the reasons for the decision. New information about 

incoming weather, for instance, may be of value.  

2.17. Launching 

The Role of the Launchmaster 

It is important that the launch phase is carried out under the direction of a single individual 

who is conversant with all aspects of tug and glider operations and is capable of directing 

tugs by radio to avoid conflicts in the air and on the ground. Tugs on the ground will have to 

be directed to their next customer and grid marshals will have to know which tug is being 

directed to which glider and which will be next to roll. It is not uncommon for two or more 

tug/glider combinations to be hooked up and ready to take up slack at the same time. 

Obviously, no-one should be in any doubt as to which is to go first, especially the tug pilots. 

During the launch phase, the Launchmaster alone is in charge. 

Helpers 

As with any glider launching operation, only helpers who know what they are doing should be 

allowed to attach ropes and run with wings. Generally, these tasks should be carried out only 

by grid marshals or the recognised crew of the glider being launched.  

Pilots’ Option to Refuse a Launch 

Any pilot may refuse a launch when offered in normal grid order. Pilots who do so must then 

use the relight procedure to launch. In practise, pilots taking this option will often position 

their gliders in the relight area without being directed to. The decision to refuse a launch may 

be made at any time, even after launching has started and grid marshals will need to be 

ready to help move the glider out of the way quickly to minimise disruption. 

Launch-Logging 

Don’t forget to make a record of launches. Glider Ident, Tug Ident and Time are all that is 

required. This information will almost certainly be required later by someone.   

Last Grid Launch 

The earliest time that the start line can be opened is based on the time that the last 

competitor had the option to launch. Gliders which have been moved voluntarily to the relight 

area have had the option, but have chosen not to exercise it, so they do not count for this 

purpose.  If the relight area is at the back of the grid (which is often the case in single-class 

competitions) it will not be obvious where the grid finishes and the relight area starts. Don’t 

make the mistake of counting these gliders.  Make sure you work from the time that the last 

glider not to have refused a launch is launched.   

Drop Zones  

Drop (or Release) Zones are areas designated in advance where gliders should be released 

by the tugs. They aid competitive fairness but are primarily a safety measure as they help to 

ensure separation of gliders and tugs through predictable tug routes. The safest situation, of 

course, is when gliders can climb and stay above release height. However, conditions can 

change during launching and circuit traffic can increase if gliders are dropped in unsoarable 
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areas.  It makes sense from both a sporting and safety perspective to use release zones but 

to remain flexible. The following recommendations are made: - 

• Release zones and towing patterns should be clearly described in Local Procedures 

and briefed during the competition so that pilots know where they are and can avoid 

them if they are unable to stay above release height.  

• Release zones should be reasonably sized and positioned so that descending tugs 

do not conflict with the tow-out pattern. 

• Release zones should be positioned to enable competitors to land safely on the 

contest site for a relaunch, after allowing adequate time and altitude to search for lift 

after release. 

• The Director may change the release zone whist launching if those about to be towed 

will be at a sporting disadvantage to those previously launched. A good example 

would be a rain shower in the zone or if it’s generally unsoarable in the zone after 

having been suitable earlier in the launch sequence – you can brief the tow planes to 

tow to a different area.   

• It is highly recommended that the tugs are fitted with Flarm. 

Relights 

Gliders may land back even during the launch phase so, if space on the airfield permits, it is 

both safer and less disruptive to brief a landing area for relights which will not interfere with 

normal launching.  It may also be practical to designate a relight launch area away from the 

grid. Moving landed gliders from the landing area to the relight launch area should not be 

allowed to interfere with normal grid launches although, in multi-class competitions, provision 

should be made to comply with the rule which requires relights from an earlier class launch to 

be merged with those of a later class. Provision should also be made for immediate relight 

where the failure to launch successfully was no fault of the pilot or crew. 

Turbo relights are permitted as covered in the Local Rules and Director’s briefings as long as 

carried out in accordance with the current Rules for Rated Competitions.   

2.18. Starting 

Start Procedure 

The start procedure has been adjusted over the years to try to facilitate the safest set of 

conditions at the start where, inevitably, there is a high glider density and resultant collision 

risk. To discourage the practice of circling extremely close to or in cloud resulting in reduced 

conspicuity, recent past measures sought to set a start height well below cloud and defined 

as the start gate opened. As a result, dive starting became prevalent. This was deemed very 

dangerous as gliders were diving and pulling up whilst others were circling slowly in the start 

area. This was subsequently outlawed with the implementation of the “5 minute” rule, later 

adjusted to the “2 minute” rule (stay below start height for two minutes prior to starting). 

Feedback from pilots, both in the UK and in international FAI competitions, where the 2 

minute rule was being used suggested that the requirement to monitor altitude, position and 

time in a busy environment where gliders are both ascending and descending to the height 

limit, produced a workload that was just too high and gave a significant temptation to 

prioritise the viewing of instrumentation rather than the visual traffic. 
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Therefore, the procedure was changed in 2010. Now, there is effectively no limit to the start 

height other than an absolute limit set an amount above cloud base to discourage the 

advantage that might be gained from a fortuitous wave climb prior to starting if this can be 

achieved while staying clear of cloud. This means that it is NOT necessary for pilots to 

monitor height or time, meaning that they are free to look out and there should be no gliders 

descending down to height in the start thermals.  

This procedure quite clearly has many advantages in that pilots can be fully focused on 

looking out for traffic. However, no specific measures other than good airmanship practices 

prevent the dangerous practice of flying in restricted visibility around and in the base of cloud 

in the vicinity of the start point, which was a contributing factor to a fatal collision that 

occurred some years ago. The Competitions Committee believes the current procedure to 

be, on balance, the safest and easiest for pilots but good airmanship does need to be 

promoted to prevent heightened risk if a pilot were to fly in severely restricted visibility. It is 

recommended that, at the beginning of the competition, the risks associated with all aspects 

of the event, including the start procedure and the airmanship required, should be discussed 

at briefing and refreshed throughout the event - in particular the significance of the 

requirement that “Pilots must remain clear of cloud and in full visibility of all gliders in the 

same thermal when within 10km of any start zone and base airfield reference point”. Please 

encourage pilots to use the Pilot Safety Committee if they think fellow competitors are being 

irresponsible. 

Please also note the total cloud flying restriction that is placed on flight prior to starting (pilots 

first or last start).  

2.19. Task Cancellation 

The Director may hold the start-line, ‘scrub’ the task prior to the start line opening, and/or re-

task. Should a re-task be considered necessary, all competing gliders must be recalled, and 

a single radio transmission should be all that is required. Once all gliders have landed back 

the task may be re-briefed and a new grid established.  

The Director must, however, allow at least one hour between the recall and the first launch to 

allow pilots to return safely and to re-plan the task. Any competing glider that has landed out 

prior to the start-line opening will not be eligible for a launch on the subsequent task.  

The Director may also re-task if, after the start-line has opened, all competing gliders land 

back without starting. 

On several occasions in recent years, a day was ‘scrubbed’ which subsequently turned out to 

have been a possible contest day. Bear in mind that at mid-summer, it is not unheard of for it 

to be soarable at 8.00 pm. This could allow a class to be launched on a moderate task as 

late as 4.00 or 4.30 pm. Please do not be tempted to ‘scrub’ too early. It is better to have 

restless pilots waiting to launch than angry pilots deprived of a reasonable afternoon contest. 

2.20. Finishing 

Finishing Procedures 

Following the tragic accident at Husbands Bosworth during the 2005 Junior World Gliding 

Championship, it is increasingly clear that flying conduct during the finish continues to require 
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careful consideration to ensure safe procedures are implemented and should be fully 

monitored to ensure that these procedures are being followed. Since 2006, the rule book 

implemented procedures and a penalty structure for dangerous flying that sought to ensure 

the protection of people and property outside the airfield.  Apart from a duty of care to ensure 

that people and property outside the airfield boundary are protected, the CAA are keen to 

assure that glider pilots observe the Law, namely the UK implementation of SERA 

(Standardised European Rules of the Air) and its associated UK exceptions regarding low-

flying and reckless or negligent endangerment of any person or property.  

It is useful to highlight what the requirements actually are and how they are interpreted at this 

time by current BGA thinking. 

The law on reckless or negligent endangerment is a “cover all” statement of Law that 

requires that pilots do not endanger people or property. There are no specifications on how 

to meet this requirement. 

The low flying law in context to finishing requires that glider pilots may not fly within 500’ of 

people, vessels and property unless protected by the exemption of being in the process of 

the procedure of landing in accordance with normal aviation practice. Normal Aviation 

practice means different things depending on whether you are, for example, a commercial 

airline, helicopter, or glider pilot. Following discussion with the CAA, the BGA view is that 

glider pilots whether competing or flying standard circuits will meet the requirement of 

exemption provided that they exhibit a descending glide profile keeping the landing area in 

view at all times and in the case of a competition final glide, where a direct landing is a viable 

option. The CAA and BGA are content with the need in many instances to ultimately find it 

necessary to pull up and go around for an abbreviated circuit, for example, where the pilot 

has a gross excess of energy, or the landing area is obstructed or for any other flight safety 

reason.  However, there is a basic need to have a viable direct landing option to be able to 

claim the required exemption. 

In the context of finishing and the close proximity to the ground in the final part of final glide 

to landing, it is clear that a minimum height rule may only be broken without penalty on the 

grounds of flight safety (including extreme low energy that may lead to landing short) and is 

appropriate to eliminate the possibility of danger to members of the public. This minimum 

height is set at 30’ above ground level and any structure, including inside the airfield 

boundary where people require the very same protection from danger. Furthermore, 

adherence to BGA best practices of a descending flight path and retain sight of the landing 

area when below 500’ is required. However, it is acceptable to pull up to change from a direct 

landing to an abbreviated circuit pattern. 

With the necessity to offer a viable direct landing option, if using a finish line, it is a 

requirement for the organisation to arrange the finish line in such a way that it is orientated 

from between 0-30 degrees to the perpendicular of the inbound track line and situated such 

that gliders can safely land directly beyond it without turning. Positioning of the finish line and 

inbound track to it should consider any potential conflict with any person, vehicle or structure 

on the approach to and around the finish line and should normally be placed near the runway 

threshold to maximise the safe landing area beyond.  A Control Point should be utilised as 

necessary to ensure compliance to the above. It is recommended that such a control point be 

ideally no closer than approx. 10km so that the pilot is not pre-occupied with landing 
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considerations whilst trying to satisfactorily round the turn point. Where the normal task line 

approaches the finish line at an appropriate angle already, a further control point is not 

necessary unless it is felt wise to promote an exact finish path to avoid approach hazards 

such as built-up areas etc. In this case, a control point is again a recommended option. If 

suitable control points are not available in the BGA list then organisers should develop their 

own control points and publish the co-ordinates in the local rules. 

It remains a requirement for the organisation to specify and use an additional specific officer 

with responsibility to share the observation of the conduct of finishing gliders with the 

Competition Director and to monitor any public activity close to the airfield boundary, which 

might pose a danger to the pilots and themselves. This officer may carry out other duties and 

responsibilities. 

The finish ring option is intended to provide a deceleration zone after finishing giving more 

time for pilots to organize their landings. However, it must be noted that the final leg must still 

be orientated when (within 30 degrees) a viable landing direction forming part of the landing 

procedure is in force at the time. Otherwise, it does not readily meet the requirements for 

pilots to meet the low-flying regulations. In cases where the landing procedure requires a 

circuit or deviation to the prescribed landing place of more than 30 degrees, an appropriate 

finish ring height should be selected in excess of 500ft and fully suitable for the landing 

procedure.  

The size of the ring must be specified (normally 3km) along with a minimum altitude which 

should be as low as possible whilst meeting the Rule requirement. Setting the minimum 

height too high results in increased pilot workload and risk with manoeuvring gliders. 

Within the penalty section of the Rules, the penalty for crossing the finish ring below the 

required altitude has been specified. Directors are reminded that when using this finish 

method, they must be prepared to routinely monitor pilots’ flight recorder records for height 

compliance. When pilots need to burn off energy as they approach a finish ring, it is accepted 

that they will likely gain height as they slow down (which cannot be avoided) and gently pull 

up to join a circuit as is necessary, however this needs to be distinguished from steep and 

excessive pull-ups, which may need to be penalised. 

The CAA has made it known that they will continue monitoring our events to ensure 

compliance to the BGA Rules and the Law. So please make sure that every effort is made to 

continue to encourage safe flying practices by careful consideration of the finishing 

procedures and continual monitoring of compliance. A clear transgression observed by the 

CAA may well lead to them taking a draconian view rather than its current standpoint of 

tolerance to our needs. 

2.21. Scoring 

As with all competitions, it is important that the scoring, together with any necessary 

penalties, are applied in a consistent and transparent way.   

The following provides some guidance and suggestions for using SeeYou Competition to 

score BGA-rated competitions.  
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They cover key points that the scorer should observe but are not intended to be a 

comprehensive ‘how to’ guide, and should be used in conjunction with the user guides 

provided for SeeYou. 

SeeYou and Scoring 

It is recommended that, as far as possible, the scoring function should be separated from the 

downloading of Flight Recorders and, if possible, assessment of prohibited airspace 

penalties. This allows the scorer to concentrate on flight analysis and scoring issues. 

The scorer should be proficient at using SeeYou to enter tasks and analyse flight recordings 

and should be familiar with competition organization and rules. Some understanding of the 

BGA scoring system is useful, but a detailed knowledge of the scoring formulae is not 

necessary.  

SeeYou Competition is a module of SeeYou (see 4.5 for a more detailed discussion). Flights 

are automatically analysed by SeeYou to check that the flight has been completed correctly 

(start/finish lines have been crossed, turn- 

points rounded, airspace not infringed etc.). It then passes task and performance data 

(start/finish times and leg distances) to a scoring script which calculates distances and 

speeds to allocate points to each pilot. A scoring script suitable for all BGA-rated 

Competitions is provided. 

Hardware and Software Requirements 

Although it is pilot’s responsibility to ensure that the organisation has the ability to download 

Flight Recorders it is advisable for the organisation to ensure that it can, if necessary, 

provide some assistance by having ready access to cables, memory card readers, and 

software for downloading commonly used Flight Recorders. 

Many contest organisations now require pilots to hand in their flight evidence on memory 

devices, to email their traces, or to download their Flight Recorders themselves using their 

own computers, or using computers provided by the organisation for this purpose. 

Arrangements and procedures for downloading Flight Recorders and submitting flight traces 

should be clearly notified in the Local Rules.  

Data Storage 

Take regular backups of all data, especially the CUC file, at appropriate points, at least daily. 

Although the CUC file can be set to autosave at frequent intervals during the scoring 

process, it is highly recommended that a separate copy be made, especially when changing 

status from Preliminary to Unofficial and Unofficial to Final. This makes it easier to roll back 

to a known point if necessary.  

Keep a written log of any manual adjustments or corrections made and any penalties 

applied. This will assist in ensuring that, should day performances need to be recalculated, 

any manual adjustments which will need to be reapplied are not overlooked. Also note times 

that each day’s scores change from Preliminary to Unofficial and Unofficial to Final. 

Submission to BGA 

When overall final results are compiled for sending to the BGA, ensure that all FAI licence 
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numbers have been included and that a note is included to indicate for shared gliders, which 

pilots flew as P1 on each day. 

Flight Recorder Evidence 

It is acceptable to allow secure IGC files to be delivered on removable memory devices or by 

email. This method of presentation actually saves the organizer time in collecting the data 

required and is to be encouraged. 

The Director must establish that a competitor has no objection to the release of their Flight 

Recorder evidence before distributing any copies of it. It is recommended that this be 

explained prior to the start of the competition and announced at the first briefing. Any 

competitor’s request to the organisers to restrict the release of their evidence must be 

respected. After the final competition results have been produced, all data from competitors 

requiring confidentiality must be deleted. It is also recommended that that it is made clear to 

competitors that it is their responsibility to clear the Flight Recorder memory as appropriate. 

Whilst the scorer will probably have obtained down-loading software to provide data in the 

standard IGC format for most propriety Flight Recorders, the onus is on the competitor to 

ensure that suitable software is provided to the organisation. It is suggested that the Local 

Rules state this fact as well as advising competitors which types of Flight Recorder software 

is already held. 

Current GPS analysis programs highlight any anomalies with the recorded data. All 

anomalies should be investigated by a visual inspection if they occur between start and finish 

and all recordings should be viewed at the control points to ensure that the occasional 

‘phantom position’ points are spotted. ‘Phantom position’ points are normally fairly obvious as 

the displacement from the rest of the recording usually exceeds a kilometre. Clearly the 

effect of a ‘phantom point’ that gives control anywhere in the flight must be discounted. 

Directors should note that it is now a requirement to have a complete flight log of the day 

including all flying on the day. This requirement is to ensure that evidence that may have 

shown a land-out and re-launch or engine start in the case of motor-glider before the start, is 

not deliberately lost. Such evidence may take the form of several IGC files. 

Competitors are, to the best of our knowledge, an honest bunch. There are, however, a 

number of simple checks that can be made, if required, to allay any suspicion. View traces to 

check that the direction of thermal drifts is similar to other competitors. For Flight Recorders 

that record GPS height, check this mirrors the barograph trace. If there is a particular 

suspect, install a flight recorder in the tug used to tow them and compare traces for that part 

of the flight. Closely compare landing and take-off times with the observed records. 

Robocontrol, which is used as a digital tool for many UK competitions as an entry and 

charging process, may do some checking of files the ensure that they come from Approved 

Recorders, however this may not be the complete answer. Checking that the second 

character of the first line in an IGC file is NOT an 'X' will not detect all unapproved recorders. 

More information on this matter is available on-line through a link available from the 

Competitions Committee. 

Also many pilots (and scorers) may not be aware that in two-seaters, while a front-seat 
recorder may be approved, the rear-seat repeater is not, even though it creates a .IGC file 
and the second character of the first line in an IGC file is not an 'X'. The rear-seat repeater, in 
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the cases that are known about, have an ENL recorded, but with a value of zero throughout, 
having no microphone hardware fitted. A valid ENL record will have an elevated baseline to 
indicate that ENL mechanism is operational, which should always be 4 or above. 
 
 Flight Recorder Evidence - Additional Requirements for Turbo and Motor Gliders 

Motor-gliders and turbo-equipped gliders are able to compete fully with pure gliders. 

Directors should be particularly aware of need to monitor FRs to ensure that engine use is 

recorded and that the flight recorders used are in fact recording noise. This can be achieved 

by ensuring baseline noise is apparent on the traces and also comparing this with real 

engine start noise recorded either on self-launch or on mandatory turbo engine test. 

Only flight recorders that are IGC approved and carry operative noise sensing (ENL) or other 

approved means of sensing engine operation (MOP) are now permitted for gliders fitted with 

any means of propulsion. The logging interval must be set to 2 seconds or less. To cater for 

older loggers where there may be problem due to memory size, the competitor must agree 

an arrangement with the Director prior to the first launch of a logger interval that enables 10 

hours duration. 

The requirement to test the noise or other approved sensor of FRs in gliders with means of 

propulsion by engine test is now only mandatory on the first day of the competition. It is at 

the discretion of the Competition Director to require an engine test for logger integrity 

purposes each day although the rules allow a pilot to test his turbo regardless as long as 

he/she does not exceed the maximum engine run allowance time which varies according to 

the rules and engine type. If the engine run time is exceeded, a penalty structure of 1 point 

per second is applicable.  

2.22. Penalties 

The approved penalty table is split into sections depending on type of offence, with differing 

penalties depending on whether it is a first occurrence of that particular offence, a second 

occurrence or subsequent occurrence. Airspace penalties are rightly placed within the 

dangerous flying section. Directors are urged to carefully read the penalty structure to 

evaluate its contents.  

There must be no discretion within the penalty structure and penalties must be consistently 

applied. In many cases, the penalty for a first offence is a “warning” only. This, along with all 

other penalties, must take the form of a notification to the pilot, ideally in written form, 

together with annotation on the score sheet clearly identifying the penalty and what it was 

awarded for. The intention is to ensure that pilot and peers are fully aware that the penalties 

are being administered, even if warning penalties, to promote compliance. It is not 

acceptable to regard a general warning to all pilots as a first offence warning. Any penalty 

must be earned individually by demonstrated specific actions that are in breach of the rules. 

When determining whether an infringement of any rules has occurred, and for assessing 

protests, the task sheet, the local rules, and the published and notified airspace file, taken 

together, will be definitive. 

Dangerous or Hazardous Flying 

This can take many forms and the various scenarios in most cases have a different penalty 
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structure. Advice on the monitoring of conduct and administration of this type of penalty 

follows: - 

• Cloud flying – incorrect protocol. Whilst this penalty may be extremely hard to award, 

due to burden of proof, it is intended to discourage, and hopefully eliminate, the 

sloppy and sometimes deliberately poor use of radio when cloud flying. There have 

been cases where pilots have been deliberately vague and have failed to call when 

clear of cloud, with the effect of increasing the tactical advantage of being “first in.” 

The correct radio protocol and airmanship considerations are clearly noted within the 

Rules and adherence to these are necessary from a sporting and safety perspective. 

• Cloud flying within 10km of airfield centre, or any start point. The 10km is now 

measured from the centre of each start point and also the airfield reference point as 

defined. This applies throughout the day and does not just apply to pre-start situation. 

Note here that pilots cannot, prior to start, cloud fly over 10km from the site, then 

return to the start line and gain an advantage over pilots that have not entered cloud 

and remained within 10km of the start line.  

 

• Minor airspace infringement including prohibited parachute zones – defined as 

“Single or multiple penetrations of prohibited airspace NOT simultaneously greater 

than 200m horizontally and 100’ vertically”. This penalty is designed to be significant 

but not draconian and is intended to discourage accidental and very minor 

transgressions. An example might be cutting airspace horizontally whilst circling or 

bobbing vertically. Note that any number of such minor infringements may be made 

on a particular contest day incurring just one penalty.  

• Significant airspace infringement including prohibited parachute zones – defined as 

“Single or multiple penetrations of prohibited airspace simultaneously greater than 

200m horizontally and 100’ vertically”. This penalty is very significant at 500 points 

with further sanctions for further infringements of this nature on subsequent days. 

Note that any number of similar infringements may be made on a day incurring just 

the one penalty. A minor infringement followed by a major infringement will not result 

in two penalties but just the higher penalty for major infringement on that day.  

• Finish – incorrect landing pattern, if specified. This is a specific penalty that can be 

awarded for failure to stick to specific briefed landing instructions. Directors will have 

to take into consideration the defence of a possible necessity to deviate from any 

briefed instructions, if not doing so would have clearly led to a dangerous situation 

occurring, e.g. due to the actions of other finishing pilots or airfield traffic or possible 

major wind fluctuations.  

• Finish and approach to finish – hazardous or prohibited manoeuvre including: 

a) Flight below 30’ AGL outside the declared airfield perimeter other than an 

emergency straight-in approach where it is not possible to maintain safe 

airspeed to maintain the minimum ground clearance or in the event of an out-

landing. FR evidence from 500’ above airfield elevation will be used to verify 

any deliberate planning of energy management that leads to flight below the 

minimum limit. Such proven cases will not be exempt from penalty. 

b) Any approach that does not describe a descending flight path other than to 

convert from a straight in approach to a go around or for reasons of flight 

safety. 

c) Flight below 30’ inside airfield perimeter except when on landing approach. 



BGA Competition Organisers’ Guide 

April 2024                          ©British Gliding Association 2024 Page 48 of 81 

The purpose of this three-part rule is to eliminate the practice of contour following and 

hedge hopping, whether the intention is to land ahead or go around after a finish resulting 

in a safe but low final glide that may meet the legal requirements and ensures that the 

landing area and any unexpected ground hazards are continually visible. The rule 

effectively precludes the possibility of flying in ground effect except in the case where a 

pilot has so little energy that flight below 30’ is inevitable to ensure safe arrival at the 

airfield. Such a situation is effectively an emergency anyway and can easily be verified by 

FR and visual observation to ensure it was not brought about by deliberate energy 

mismanagement in the final 500’ of the flight. A decision made well back at higher 

altitude, for example to leave lift and set off on final glide, cannot be held against the pilot 

if ultimately the decision later results in an extremely marginal situation. For the purposes 

of assessing whether a pilot maintains a descending profile, Directors should consider it 

acceptable to still be dolphin flying between 200’ and 500’(although this should not be 

briefed as acceptable) as at medium speeds and in a height band where strong thermals 

may still prevail, it may well be impossible to maintain the necessary profile. However, 

below 200’, where lift is usually rarer and the visibility of the landing area and proximity to 

the ground are major issues, then a descending profile should be displayed to avoid 

penalty. After crossing the finish line, the minimum safe height must be maintained until 

the final part of the approach to land if a go around is selected. 

The Director and the appointed finish line observer must between them monitor the 

conduct of all aspects of the flying from being visible to the eye on approach and 

completing the flight. It is not the intention of catching out pilots who are at 29 feet up or 

on a virtually flat approach path but to cut out irresponsible hedge hopping and contour 

following where it is not necessary to complete the task. Such flying will be clearly 

identifiable. 

Verification of any of the final glide conduct should not be routinely checked by FR 

analysis but where dangerous conduct is observed, can offer additional evidence within 

the limits of its resolution. 

2.23. Competition Forums and Feedback 

The Competitions Committee recognises that communication and consultation between 

itself, competition organisers and pilots is essential and sees competition forums as one very 

effective way of achieving this. Directors of Nationals are required, and Directors of 

Regionals are strongly encouraged to hold at least one forum during their competition.   

As well as providing a platform for feedback to the organisation about their own competition, 

these forums allow the Competitions Committee to keep abreast of developing issues that 

are seen as important within the competition community and to consult on proposed or 

recently introduced changes to rules and recommended practices.  

Forums may be arranged on an ad-hoc basis by the Director at any time and may cover any 

topic or topics chosen by the Director or by the pilots present.  In addition, however, the 

Competitions Committee may wish to seek input on specific matters of concern and may 

wish to “seed” topics for discussion.   
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Guidelines for Arranging a Competition Forum 

• Pre-Announce in the Local Rules. If pilots know in advance that a forum will be held, 

it may help them get their thoughts together and add to the effectiveness of the 

exercise.  

• Consider asking for suggested forum topics in advance. That could give you a good 

idea as to what is “hot”. 

• Pick your time. Consider when you are likely to get a receptive audience. Just after a 

scrub briefing will give the highest attendance but will be hard to plan in advance. On 

the other hand, a pre-planned evening meeting may find most of your pilots otherwise 

occupied unless it is linked to some other event that you know will be popular. 

• Start on a specific topic that you already know will provoke debate. Avoid opening 

with “Does anyone have a topic they want to discuss” You are very likely to get the 

“Stunned Mullet” response. 

• Pick up other topics as the discussion develops. There may be a tendency to drift off-

topic.  Note interest in any new issue and come back to it later. 

• Consider a “Panel” approach. Sometimes a “Panel of Experts” can be a good way of 

getting things moving since questions can be asked direct from the floor, or by the 

chairman if the audience is shy. Pick your panel carefully in advance. 

• Spread the load. Get someone else from your organisation to take notes. It’s not easy 

both to chair the discussion and make a decent record.  

• Don’t let a few noisy people distort the feeling of the meeting. Where there is 

disagreement consider taking a show of hands to make sure any “silent majority” gets 

proper recognition. 

• Include a summary of your forum in your Director’s report. 
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PART 3 – CHECKLISTS 
 

3.1. Getting Started 

Competition Nationals, Regionals, Non-Rated? 

Application to 

BGA 

Unless you are running a Nationals, in which case you will have 

gone through a bidding process, you will need to advise the BGA 

of your intentions to run a rated competition. In either case, it is 

essential that the information required in section 1.6 is 

communicated by March 1st in the contest year.  

Fees and 

Charges 

Clubs are free to set entry fees for Regional Competitions. Decide 

entry fee, deposit amount and due date. Consider special offers 

such as discount for early booking etc.  Set due date for payment 

of fees. Decide if you need a refund policy. 

Promotion How is the competition going to be advertised? 

Web Presence Onglide? Home-Grown website? Will you have a blog? 

Entry Admin 

Entry list automated on website or manually using club office staff 

or other volunteer. Bank account for entry fees? Sort codes and 

Account number to allow direct transfers. 

People 

Who will be Director, Deputy Director, Met-Man, Task setter, 

Scorer, Airspace Officer Safety Officer, Control, Launch Marshalls, 

Stewards, General Helpers. Will there be enough people to help 

throughout the competition? 

Tugs 
Enough to launch each class within 1 hour. Arrange well in 

advance, or risk having too few. Don’t forget to allow for outages. 

Accommodation 

Where will competitors stay: bunkhouse? Local B&B’s (list?). How 

many pitches?  Will you charge for camping/caravans?  Are 

electric hook-ups available? 

Refuse Disposal You will need more than usual. Hire a skip? 

Catering 
There will be many mouths to feed. This can be a great revenue 

source for your club but will need dedicated staff and facilities. 

Communications 
How will you communicate with competitors at the competition? 

Notice Boards/PA/Text Messages/Airband/Website? 

Radio 
Do you have enough air band handhelds?  Is there a base-

station? Consider range and readability of handhelds if not. 

Local Rules Who will write these? 
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Sniffers A sniffer should be on call every day.  Has this been organised?  

Club Operations 

Will normal club operations be continuing during the competition? 

If so do you have a procedure for coordinating club flying with 

competition activity? 

Deputy Director 
Have you appointed a deputy director to take over if necessary? 

This is a requirement of the rules? 

Stewards Have you appointed competition stewards? 

Briefings 

Where will briefings take place and will pilots have adequate 

seating and table space? What presentation aids are available? 

Computer projector and screen almost essential. 
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3.2.  Airspace 

Airspace Officer 
Have you appointed an Airspace Officer?(This is a 

requirement) 

Advance Information 
Have you published advance airspace information in your 

Local Rules? (3 weeks before the comp) 

Competition NOTAM 
Check it has been created and is correct. It may not appear 

until close to a week before the competition. 

Airspace Coordination 

Notice (ACN) 

Have you received it? Do you understand the Coordination 

Arrangements? Are you clear on how you will comply? 

Co-ordination 

Have you obtained contact details for other airspace users 

in your likely task areas who may have to be contacted? 

No good looking for their numbers on the day.   

Local Hazards 

Have you identified any airspace hazards in your local area 

that visiting pilots may not be aware of? These should be 

highlighted in your briefing. 

Temporary Hazards 

Have you taken steps to ensure that any short-notice 

temporary hazards can be identified? (Red Arrows phone 

line, AIS InfoLine, for instance) 

Airspace Dispensations 

Have you identified the potential airspace dispensations 

that you may wish to make use of in your likely task areas? 

(Nuclear site fences, Bath Gap, Daventry Box etc.) If any 

prior action is required to invoke them, have you taken it? 

Airspace Files 

Do you intend to issue supplementary airspace files to the 

competitors for use in their moving-map devices? If so, 

how will these be distributed? 
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3.3.  Safety 

Safety Officer 
Has a Safety Officer been Appointed? This is a requirement of 
the rules. 

Emergency Action 
Plan 

Do you have an emergency action plan and Is everyone 
aware of it and their role in it? 

Coordination with 
Other Flying on Site 

If other flying operations will be taking place at the host site 
during the competition, have you considered possible conflicts 
and alerted the other users? If club-flying is planned to 
continue, has a club/competition liaison procedure been 
agreed and published? 

Safety During 
Launches 

Have you thought through the potential safety issues 
connected with launching and worked out how to deal with 
them, and briefed your ground crews? (See “Safety” in Part 
2), 

Safety During 
Finishes 

Ditto finishing  

Ground-Traffic 
Safety  

There are likely to be a lot of visitors unfamiliar with your site 
and your normal safety procedures. Are any additional traffic-
control measures and associated signage in place or 
available?  NB this applies to pedestrians as well as vehicles. 

Pilots’ Safety 
Committee 

Are you clear on the role of the PSC and the procedures 
associated with it? (See the relevant section in Part 2) 

Local Hazards 
Have you included local hazards in your briefing material? 
(E.G any local unlandable disused airfields?) 
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3.4.  Control 

Control Area Have you allocated a separate room or area?   

People 
Are people available throughout the competition to run control? 
Do they know what they must do? 

Equipment 
Tables/Desks Chairs. Office Supplies, Pin boards and White 
Boards.  Supplies of pins and dry-wipe markers 

Computers 
Will people use their personal machines, or do you need to 
provide one or more?  Internet Access? Cable or Wi-Fi? 

Printers 

Will you have a dedicated printer? Is it fast enough? Don’t 
underestimate the printing load. Up to three alternate task 
sheets plus results sheets per pilot per day, plus sundry other 
bits of paper. All produced before briefing each morning. 

Accommodation 
 Where will the competition officials call home?  Scorer, Met 
Man, Task-Setter, Director all need workspaces.  

Information 
List of entries, Contact Numbers of local airfields, Contact 
numbers for local services?  Copies of emergency procedures. 
Copy of Competition Rulebook 

Security 
Is there secure storage for pilots’ property (loggers and memory 
devices)?  Is the control centre lockable? 
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3.5.  Meteorology 

Met Man 

Do you have a dedicated met man for the whole competition? If 

not, can you provide met briefing cover every day? If not, use 

someone with competition met briefing experience.  Has a 

briefing format been communicated to the volunteers, and have 

they practiced preparing it?  

Internet 
Met forecasting is practically impossible these days without 

good internet access.  Is this available? 

Briefing 
Best not to attempt live internet at briefing. Images should 

ideally be pre-loaded to memory sticks. 

Ad-Hoc updating 
Will you have the ability to update forecasts during the day? 

This is invaluable on days when launching may be delayed. 
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3.6.  Task Setting 

Director 
Do you have a task-setter for every day of the competition? Is 

there a back-up in case of illness or other absence?  

Task-Setter  

Establish where, and when, you will receive your meteorological 

information.  If necessary, more detailed information can be paid 

for through some of the subscription services that the Met Office 

provide. 

Director 

Ensure adequate computing and printing/copying facilities are 

available. Ideally connected to the internet and a competition 

LAN with Printer. The tasksetter is going to want to look at 

weather forecasts, NOTAMs etc. and will need to print task 

sheets.  

Director 

Ensure SeeYou is available for task setting and scoring. SeeYou 
from Naviter is the only complete competition management 
system with inbuilt scoring that creates the task sheet to the 
required standard.   

Airspace 

The likely temporary airspace for a particular day can be 

established the evening before a competition day.  It is useful that 

the Task Setter has this information when he discusses the task 

shape/distances with the Met Man. 

Task-Setter 

Before breakfast check the likely task areas, thermal strengths 
and soaring ‘window ’with Met Man.  Calculate best-worst case 
task lengths based on information available.  Where confidence is 
high consider a Task A and a Task B.  Where confidence is lower 
consider adding additional fall-backs and potentially different task 
directions. 

Airspace  

Confirm airspace for the day with Task Setter and how this may 

impact on the final tasks that have been decided by the Task-

Setter.   

Airspace Provide information for Task-Sheet in format required. 

Task-Setter Create tasks on See-You and in the format required.   

Director  

Review Tasks independently of Task Setter.  Involve Airspace 

and Met-Man if necessary.  Check task sheets for suitability and 

ensure that trigraphs, turning point descriptions, airspace and 

ATZ information are correct. 

Admin Print and copy Task Sheets. 
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3.7.  Ground Marshalling 

Team 
Do you have enough capable volunteers for every day of the 
competition? 

Hi-Viz Vests One per marshal plus some spares 

Grid Plan 
Have you determined the format of the grid?  Are you clear on how 
the grid positions are to be calculated and communicated to the 
pilots from day to day?  

Grid Cones Or equivalent.  How many do you need? 

Release Check 
Ropes 

Not everyone will want to bother, but some will and you can’t wait 
until the tug is there. 

Rope Hooks 
Invaluable. One per marshal plus a couple of spares. Know how to 
use them (Two marshals per rope pulling in opposite directions) 
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3.8.  Scoring 

Software Have you organized access to SeeYou licence(s) 

Scorer 
Has a scorer been appointed who is familiar with the scoring 
software? Is there a back-up in case of absence? 

Hardware 
Does the scorer have exclusive use of a computer? Is there a 
back-up available? 

Security 
Do you have the means of storing competitors’ property 
(loggers and/or memory devices) overnight if necessary? 
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PART 4 – REFERENCE 

4.1 Example of the Daily Schedule at a Single-Class Regionals 

The following table shows the daily schedule at a single-class regionals. It is intended to 

illustrate what a competition day is like from the Organisation’s point of view. Details will 

differ from club to club and between the different types of competition. Although it may not be 

written down, the Director and Competition Officials at every competition will be working to 

ensure that each day is conducted in accordance with a schedule not unlike this. 

When What Who Notes/Detail 

07:15 Preliminary Met 

Review  

Met –Man 

Task setter 

Review preliminary forecast. 

Identify potential tasking options.  

07:30 Preliminary Airspace 

Check 

Task setter Review NOTAMs & RA(T)s  
Check AIS Info Line (0500 354802) for new restrictions. 

07:45 Preliminary Tasks  Task setter Refine task options.  

08:30 Morning Meeting Director 
Met Man 
Task setter 
Airspace 
Safety 
Launchmaster 
Control 
Scorer 
Chief Grid Marshal 

Confirm previous day’s scores can be published at 
Unofficial status.  

 
Review any organisation, safety, penalty or other issues 
to be dealt with or mentioned at briefing. 

 
Review airspace issues, NOTAMS & RA(T)s 
Review Met and Task Options 

 
Airfield operations and gridding Plan for the day 
 
Identify ATC Units and airfields to be advised 
 
Admin issues to be raised at briefing. 
 
Publish rig and grid instructions to competitors if not 
already done 

No Later Than 

09:15 

Club Flying Liaison Director   

Club Duty 

Instructor 

Discuss planned club operations and any issues arising.  

Before briefing Publish unofficial 

scores from previous 

day 

Scorer 

Control 

Print Unofficial score sheets with time and date of 

publication for distribution at briefing.  

 

NLT   09:00 

 

Obtain grid briefing 

from Launchmaster.  

Post grid positions 

notice and lay out 

Grid Markers 

Chief Grid 

Marshall & helpers 

To permit gridding before briefing.  CGM may need to 

look into morning meeting to get briefed if grid position 

not previously decided. 

NLT   09:30 Produce Master Met 

Briefing  

Met Man Files for presentation on-screen plus any printed data 

for pin-board or pilots.  

Copy files to Control server.  

NLT 09:30 Produce Task and 

Airspace Briefing 

Data and Task 

sheets 

Task setter Tasks to Control server for printing  

NLT 09:45 If 

grid before 

briefing; 

Gliders arrive on grid Pilots Assisted and directed by CGM and marshals where 

necessary 
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otherwise as 

directed 

NLT 09:45 Print Met Briefing 

Sheets  

Met man with help 

from Control 

Post on briefing pin board and place on pilots’ tables in 

briefing area 

NLT 09:55 Print Task and 

Score Sheets  

Tasksetter  

Control 

Place on pilots’ tables in briefing area 

10:00  Day Contest Briefing Everyone See separate Briefing Checklist  

ASAP Brief Tug Pilots Launchmaster Ensure Tugs are ready and fuelled. 

Review operation for the day including DZs and 

landing/taxiing procedure for launch phase. 

ASAP Contact RAF 

Wittering and 

LATCC (Mil) LJAO 

as per ACN 

Advise ATC Units 

and airfields in task 

area 

Control RAF Wittering - Low Flying Ops Sqn – LF Booking Cell 

(LFBC) Tel: 01780 783838 Ext 5008. Free Phone 0800 

515544. Free Fax 0800 3892225)  

LATCC (Mil) LJAO, ATC Supervisor (Tel: 01489 61 2417). 

ACN No. ACN 2011-08-0028 (Locations and contact 

details in UKAIP) 

ASAP Configure tasks for 

today in Onglide 

Scorer/Control  

Any time after 

briefing 

Make blog entry Any authorised 

blogger 

NB: Blogs may be made at any time provided they are 

relevant and interesting. However, no task information 

should be given until the actual task being flown is 

confirmed. 

ASAP Compress Grid CGM & Marshalls Late arrivals to back of grid. 

At discretion 

prior to launch 

phase 

Launch Thermal 

Sniffer 

Director Determine thermal strength and cloudbase. Use 

information to inform max start height, launch time and 

start open time decisions. 

NLT 30 mins 

before 1st 

launch 

If new task not 

previously briefed is 

to be flown. Brief  all  

pilots (on grid)  

Director Use sign-off sheet to ensure all pilots aware  

NLT 15 mins 

before 1st 

launch 

If previously briefed 

fallback task is to be 

flown or if change to 

AAT designated 

time is made. Inform 

pilots 

Director Use sign-off sheet to ensure all pilots aware 

As soon as 

task to be 

flown is known 

Set wind and task in 

Onglide and 

Rebrief/launch time 

info. 

Control  
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NLT 10 mins 

before 

announced 

earliest 1st 

launch time 

If launching is to be 

delayed, announce 

new earliest 1st 

launch time. 

Director Announcement will usually be made on Grid PA and  on 

competition frequency 

The length of launch time slippages will be determined 

by circumstances but should not usually be less than 15 

minutes at a time.  If pilots have been waiting on the grid 

for an extended period, consideration should be given 

to a longer comfort/snack break. 

NLT 10 mins 

before actual 

1st launch 

Stop Club 

Launching 

Director Contact Club Duty Instructor or LPC and request 

cessation of club launching 

NLT 10 mins 

before actual 

1st launch 

Announce 10 mins 

to 1st launch. 

Director 

Control 

Announcement will usually be made on Grid PA and on 

competition frequency. May be repeated on clubhouse 

PA by control. 

NLT 5 mins 

before actual 

1st launch 

Announce 5 mins to 

1st  launch 

Director 

Control 

Announcement will usually be made on Grid PA and on 

competition frequency. May be repeated on clubhouse 

PA by control. 

NLT 5 mins 

before actual 

1st launch 

Invoke Traffic 

Control measures  

Chief Grid 

Marshall 

Specific measures, including signage and manning, 

prepared in advance for every possible launch position. 

Goal is to ensure separation of vehicles and people from 

launching gliders or tugs that are landing or taxiing.   

At discretion  Commence 

launching 

Launchmaster Pilots offered launches in grid order. All to have been 

offered launches with 1 hour 

As soon as 

launching 

starts 

Confirm launching 

on Onglide 

Control  

During Launch 

Phase 

Record launch 

details 

Control at grid Glider ID, Pilot(s) Name(s), Tug ID, T/O Time. 

Enter to Club Record system off-line (ideally same day). 

As late as 

practical 

Decide Start Open 

Time 

Director Start Open Time >=Last Launch offer +15 mins + 1 min 

per 200ft that that cloud base exceeds 3,000 ft. 

Advise Control 

When advised 

by Director 

Enter Start time and 

Max start Height on 

Onglide 

Control  

Start Open 

minus 10 

minutes  

Announce Max Start 

Height and 10 

minutes to Start 

Open  

Director or Control On Competition frequency  

Start Open 

minus 5 

minutes 

Announce Max Start 

Height and 5 

minutes to Start 

Open 

Director or Control On Competition frequency 

Start Open 

minus 1 minute 

Announce Max Start 

Height and 1 minute 

to Start Open 

Director or Control On Competition frequency 

Start Open  Announce Max Start 

Height and Start 

Line Open  

Director or Control On Competition frequency 
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After Start 

Open 

Monitor pilots’ 

reporting start times 

Control On Competition frequency 

Acknowledge and record. 

At any time Make blog entry. Any authorised 

blogger 

NB: Blogs may be made at any time provided they are 

relevant and interesting. However, no task information 

should be given until the actual task being flown is 

confirmed. 

Once task 

under way 

Issue approval for 

club flying to restart 

Director Only when risk of relights is low. 

During Task Man telephones for 

landouts and deal 

with any that arise. 

Control Handle landouts  

NLT 0.75 hr 

before first 

expected 

finisher 

Stop club winch 

launching 

Director Contact Club Duty Instructor or LPC and request 

cessation of club winch operations immediately 

Before Finishes Station lookouts on 

landing threshold (if 

necessary) to 

control walkers 

Grid Marshall Only necessary if finish is from East 

In good time 

for finishes 

Monitor finish calls 

and acknowledge. 

Respond with 

information if 

required 

Director, backed-

up by Control 

On competition frequency. Record finishes. 

During 

Finishes 

Observe all finishes 

from suitable 

vantage point  

Director 

Safety Officer 

Ensure finishes meet safety and airmanship 

requirements. Note IDs of any offenders 

During 

Finishes 

Log all finishers Director, backed 

up by Control 

Note glider ID and Time and record 

During 

Finishes 

Clear landing areas Grid Marshalls Ensure landed gliders are cleared quickly to edge of 

landing areas. Supervise movements thereafter if 

necessary.  Goal is to maximise available landing area 

for later finishers. 

When all 

gliders 

accounted for 

Restart club 

operations 

Director Contact Club Duty Instructor to restart club operations. 

Within 60 

minutes of 

each landing 

Receive pilots’ flight 

evidence 

Control NB: All loggers and/or memory devices to be logged in 

and out using a written log.  All such devices to be kept 

securely under the personal supervision of a 

competition official or in safe. 

ASAP Carry out scoring 

process 

Scorer  

ASAP Confirm all pilots 

accounted for. 

Director 

Control 

Have land outs made contact with their crews? Count 

other finishers. If necessary, invoke missing aircraft 

procedure.  

ASAP Evening Meeting Director 

Scorer 

Review Preliminary Scores 

Monitor engine tests for turbos on first day 
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Other interested 

officials 

Apply any Penalties 

Consider any Protests 

ASAP Print and publish 

Day score sheet at 

Preliminary status 

Scorer Including upload to Soaring Spot, if used. 

At any time Make blog entry 

regarding outcome 

of the day 

Any authorised 

blogger 

NB: This can be done the same evening, or the following 

morning, if more convenient. 
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4.2.  Task Sheet Specification 

The Rules require that a task sheet must be supplied to pilots for each task briefed with 

minimum content to include the following: -  

• Task date and priority designation 

• Written task description to include trigraph, description and co-ordinates of start, 

finish, and turn points in degrees and decimal minutes, task length, leg lengths, leg 

headings(degrees true), 

• Written observation zone description where task is an AAT 

• Graphic interpretation of task area (minimum size A5) showing all observation zones, 

track lines, all relevant permanent airspace boundaries and any temporary 

restricted/prohibited airspace including prohibited parachute zones identified as 

shaded areas. 

• List of relevant temporary restricted/prohibited airspace and prohibited parachute 

drop zones to be titled as ADDITIONAL PENALTY – to include time, location and 

height descriptor as appropriate. In the event of any discrepancy between graphical 

and text descriptions of such airspace/parachute zones, the text version will always 

be authoritative. 

• Written list of relevant navigation warnings with descriptors as appropriate to be titled 

as ADVISORY 

• Written list of relevant airspace exemptions in operation to be titled EXEMPTIONS. 

• Radio frequencies of any ATZ within 5km of track lines and start volume for speed 

tasks and discretionary for Assigned Area Tasks. 

See overleaf for an example Task Sheet.  
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4.3.  Creating the Task Sheet 

Task sheets meeting the required specification can be readily created using the most popular 

SeeYou task setting software. Other task planning software has not been tested.  

Producing a graphic interpretation that suitably illustrates the normal and any additional 

restricted/prohibited airspace as well as the graphic details of the specific task is particularly 

important. To achieve this when using SeeYou, task setters should consider turning off 

unnecessary cluttering detail like turn points and their labels, waterways etc., perhaps 

leaving just towns visible on the underlay. The normal airspace will need to have its graphic 

detail specification changed within the program to ensure it is displayed in outline only, 

preferably in black and somewhat thicker than the default setting – this will allow standard 

airspace to show up clearly as a lattice across the task sheet map.  

Additional prohibited/restricted airspace (Additional Penalty airspace) must be shown as 

shaded.  If the task sheets are to be produced by photocopying, this can be achieved by 

printing a master copy with all airspace in outline only and then shading the master copy by 

hand with a pencil or similar before photocopying.  In this way, additional information labels 

showing vertical airspace level definitions may be added by hand to any airspace area thus 

offering additional clarity for pilots. Such additional labelling is not a requirement of the rules 

however. Alternatively, organisers may wish to print task-sheets direct from SeeYou without 

having to use photocopying. See the next reference section for advice on how this can be 

achieved by creating an Additional Penalty airspace file for SeeYou. 

In order for the map to be maintained at the required A5 size or bigger when using SeeYou, 

care is required with the set out of the additional written information. Written into the SeeYou 

software is automation to shrink the map giving preference to the number of lines of text 

incorporated. This is why it is recommended to turn off the “written observation description” 

section where the task is not an AAT. Additionally, and most importantly, lines of manually 

added text should be optimised to use up the bulk of each line thus minimising the number of 

lines used. As an example, four sections of additional prohibited airspace (additional penalty 

airspace) can be written as per the example below rather than listed vertically using 3 lines 

and a further one for the title: 

ADDITIONAL PENALTY – Sibson, WOG, RA(T) 5m rad Nxx.xx.xx E xx.xx.xx 1210-1320 local  

The same “long line” listing approach should ideally be adopted also for ADVISORY and 

EXEMPTION airspace as well as any other pertinent or required written data on the task 

sheet. 

You will have noticed that the three title classifications of ADDITIONAL PENALTY, 

ADVISORY and EXEMPTION have been defined and standardised so that, from one event 

to another, pilots will be clear on the intention of the information supplied.  

Items to be included in the ADDITIONAL PENALTY written section should be self-

explanatory but must include all deemed active parachute zones, any RA(T)s, ATZs that 

have been specified in the local rules as sensitive and requiring blanket prohibited status, 

and any other airspace that has been activated by NOTAM and is therefore illegal to enter. 

Whilst normal prohibited airspace like, for example, the Daventry CTA can and should be 
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detailed in any verbal briefing, this should NOT be included within the title line of 

ADDITIONAL PENALTY. 

Items to be included in the written EXEMPTIONS section should be self-explanatory but 

might, for example include the Compton Box, Daventry Box or similar. The specification of 

such areas made available to pilots at times during the event by exemption should be 

detailed in the local rules. 

Items to be included in ADVISORY should include any information regarding any activity 

demanding pilot attention for safety purposes and will usually be other activity identified by 

NOTAM that requires attention from pilots on the basis of good airmanship but is NOT 

prohibited airspace. Please note that an additional requirement (since 2011) is to provide 

detail on the task sheet of the radio frequency of all ATZs within 5km of the track lines. This 

serves to remind pilots of their duty to avoid these unless they are in radio contact with the 

radio service attached to the ATZ or have at least attempted to make contact before entering. 

Such information should appear under the ADVISORY heading. 

To avoid doubt, it is recommended that a declaration is added to the text notes to clarify the 

format of co-ordinates (should be degrees and decimal minutes) and time zones of any times 

given.  

Don’t forget to add Control contact telephone numbers. This can be done without using 

space in the text section if you put it in the footer. 
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4.4.  Competition Airspace Files 

Competition organisations typically generate a competition-specific airspace file for use in 

SeeYou task setting and scoring, and also publish the file for use by competitors. It is 

important that such competition-specific files include all sensitive airspace, including any 

temporary restricted airspace such as RA(T)s, so that tasking can take into consideration 

such sensitive airspace, scoring appropriately identifies and penalises entry into prohibited 

airspace, and competitors using the file inflight can be shown all sensitive airspace on 

moving maps and given airspace proximity warnings. 

Temporary competition-specific airspace will normally be based on RA(T), CAS(T) or other 

temporary airspace restrictions promulgated by NOTAM. These restrictions are usually 

published in advance but may be issued at any time during a competition. Given the potential 

for short notice of an airspace restriction affecting competition flying, revisions to the 

competition airspace file may be required during the competition. RA(T)s are usually 

published well in advance on the effective dates and should be included in the competition 

airspace unless well clear of the potential tasking area. 

The competition organisation should determine and specify any additional airspace that 

should be permanent penalty zones throughout the competition. These will normally include 

the most active parachuting sites such as Langar, Sibson and Chatteris, and possibly some 

less active parachuting sites, e.g. Redlands, that can be briefed as penalty zones on a daily 

basis. Non-starred Danger Areas that you believe will be active during the competition and 

any *D danger areas should be designated as penalty zones. (*D zones are permanent 

penalty zones, see 2.6). 

Penalty zones that are known in advance and are likely to apply throughout the competition 

period should be included in the baseline competition airspace file. Individual zones can be 

notified inactive in the daily briefing and on the ‘exemption’ section of the task sheet. 

SeeYou uses a single competition airspace file for scoring at any one time. It is therefore 

important to ensure that the file used for scoring on a given day contains the correct penalty 

airspace. The recommended practice is to allocate a version number to each file, starting 

with ‘v1’ for the base competition airspace file that is issued to competitors in advance, then 

‘v2’, ‘v3’ and so on with any amendments to reflect temporary changes (RA(T) or NOTAM). 

The version number in use on a can be notified in daily briefing and on the task sheet. 

Creating a base competition airspace file: 

Go to www.asselect.uk and download an airspace file in the OpenAir format. This file, with 

any permanent penalty zones added before first issue, will become the competition baseline 

airspace file (version 1). 

ASSelect has several user options. The recommended ASSelect options can be found on the 

website’s ‘help’ section. Options that are particularly noteworthy for competitions in the 

‘Extra’ section include Letters of Agreement such as the nuclear site boundary exemptions 

and controlled airspace exemptions such as the Bath and Compton ‘Boxes’. 

http://www.asselect.uk/
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Adding additional airspace to the baseline file: 

The base competition airspace file from ASSelect will be in the OpenAir text-based format. 

Additional penalty zones for temporary airspace restrictions can be included in the 

competition airspace file with relative ease using the method below. 

1. To add an additional airspace restriction issued by NOTAM, use the Spine NOTAM 

software to list only the relevant airspace by deleting all the others. Save the result in 

OpenAir format. 

2. Open this new file and the competition airspace file together and copy/paste any 

zones you wish to add from the new file to the competition airspace file. 

3. Check that all penalty zones in your new Additional Penalty Airspace file have been 

set to airspace class P (prohibited). This is to ensure that the airspace is shown 

shaded the same as all other prohibited penalty airspace. 

4. Save the amended competition airspace file with a new version number (e.g. if the 

current file is v1, then the new file should be v2). 

5. Upload the new airspace file to Soaring Spot and ensure that the correct version is 

noted on the task sheet. 

6. Print the task sheet and check that the shaded additional penalty areas are clearly 

visible. If not adjust the colour/fill parameters in SeeYou until they are. 

Note: Some familiarity with airspace text files in OpenAir format is required. Fortunately the 

format is not difficult to master. See http://www.winpilot.com/UsersGuide/UserAirspace.asp 

for a description of the OpenAir format. You will also need to be able to use Spine, the 

Notam programme written by Jeff Goodenough and available free from 

http://www.jeffg.co.uk. 

Additional guidance 

Competition organisations that would like assistance in developing and amending their 

airspace files, are advised to get in touch with the Competition & Awards Committee. 

http://www.winpilot.com/UsersGuide/UserAirspace.asp
http://www.jeffg.co.uk/
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4.5.  Scoring 

New Scoring Guide 

A new scoring guide is due for publication early in 2019.  It includes step by step guides 

(using multiple screenshots) showing how to use SeeYou to score a competition, create 

airspace and waypoint files and a guide for competitors on how to create their IGC ranking 

list ID. Look out for it on the BGA website and on the Competition Organisers’ Facebook 

forum. The new Scoring Guide is intended ultimately to replace the rest of this section 4.5. 

Setting up SeeYou for Competition Use 

For scoring, it is recommended that one computer per competition class be dedicated to run 

the scoring software. Using laptop computers for this purpose can give the scorer some 

freedom to work wherever is convenient to him/her.  

It is not necessary to purchase a separate licence to use SeeYou for scoring a competition. If 

you do not have a licensed copy of SeeYou, Naviter will supply a free licence for use in any 

competition; see http://www.naviter.com/products/seeyou-competition/  

For airspace checking, SeeYou Competition can be set up to automatically flag potential 

violations, but the maximum vertical and horizontal penetrations will need to be manually 

assessed. 

It is often useful for scorers to have access to spreadsheet and word processing software 

and a printer. 

Immediately before the competition starts, check the Competitions & Awards section of the 

BGA website for the latest version of the scoring script to include in your SeeYou 

Competition. 

The scoring script is a text file. Before use, you will need to use Notepad (or similar) to edit 

the file, using the instructions included at the start of the script, to ensure that CompClass is 

set to the correct Competition Class for the competition that you are scoring. This must be 

done before importing the script into SeeYou Competition. 

The scoring script receives flight analysis data (start/finish times, actual leg distances 

achieved) from SeeYou Competition, calculates wind-handicapped distances and then 

scores performances as described in the BGA Competitions Rule Book. 

If results are to be published on Soaring Spot, then note that SeeYou automatically publishes 

flight traces during preliminary scoring. If you wish to stop this happening, it will be necessary 

to manually upload results after any traces that are not to be published have been removed 

from the day’s sub-folder. 

If results are to be published on Soaring Spot, then note that SeeYou Competition 

automatically publishes flight traces during preliminary scoring. If you wish to stop this 

happening, turn off the relevant option in the SeeYou contest settings. 

Ensure that the competition waypoint list has been loaded, usually the BGA list together with 

any locally defined start, finish and control points. 

Start up SeeYou, and under Tools>Options: 

http://www.naviter.com/products/seeyou-competition
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7. Click on General and ensure that the  

units for distance, speed etc. are set as desired. The recommended settings are: Distance: 

Km, Speed: km/h,  Altitude: ft,  Vertical Speed: kts,  Wind: kts 

 

8. Click on Observation Zone and set appropriate default values for Start, Waypoints and Finish 

(see BGA Competitions Rulebook: Sections 5.6,5.8 & 5.9).  

Important: If setting up a finish line with a fixed orientation, the angle given should be the 

direction that the finish line faces.  i.e. if the finish line lies north/south and finishes will be 

made from the west, then the finish line direction (Angle12) should be 270 degrees. 

9. Click on Flight and select how altitudes should be adjusted  

SeeYou will use the airfield elevation and an average of readings from the Flight Recorder 

immediately prior to launching to adjust altitude fixes to QNH or QFE according to this 

selection. QNH is recommended. 

 

Use File>Open to open the Competition file and then Edit>Contest Properties 

10. On General tab 

Enter correct contest title, contest site, start/end dates, class name and enter airfield elevation 

under take-off altitude elevation. Note: airfield elevation may be adjusted by SeeYou as it 

converts to metres before storing the value, and then back to feet for display. 

11. On Options tab 

Ensure that Need tasks leg data in scoring script is checked. 

If this is not done, the scoring script will not function. 

12. On Scoring Scripts tab 

Import your copy of the scoring script (with the correct class already set). 

13. On Warnings Tab 

Ensure that max recording interval (for Flight Recorders) is set to 12 seconds (BGA 

Competitions Rulebook: Rule 5.5.6) and check the box for airspace violation is found so 

that airspace violations will be flagged during the scoring process. 

 

After Registration 

When all pilots have registered, you can either manually enter competitor, glider and 

Flight Recorder information using Edit>Add Pilot, or you can use Notepad to edit the 

information directly into the Competition file (note: this is only possible with .CUC files. In 

later versions of SeeYou, the .CUCX file is not editable outside SeeYou). 

 

Ensure that all competitor and glider information is correct. Note: the default speed 

indices given by SeeYou Competition for any glider type should not be used, as they do 

not necessarily match the BGA speed indices. Correct speed indices are listed in the 

BGA Competitions Rulebook: Section 7.3. 

 

Scorers for National level competitions should note that Pilots' IGC Rankings can be 

automatically updated from results on Soaring Spot, and should therefore ensure that the 

relevant field in the SeeYou Competition file is correctly filled. See 

http://www.sgp.aero/igcrankings/competitions/instructions-for-scorers.aspx for 

instructions. 

  

Additionally, in all rated competitions it is also useful to enter the pilots' FAI licence 

numbers in the 'Registration' field (this is done automatically during registration for users 

of OnGlide).  This will be needed to enable future plans to automate some of data 

gathering for BGA rating list calculations. 

http://www.sgp.aero/igcrankings/competitions/instructions-for-scorers.aspx
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Take extra care to ensure that the four-character Flight Recorder idents have been 

correctly declared on entry forms, and recorded in the Pilot’s details. SeeYou Competition 

uses this ident to determine which pilot a flight trace is from. 

 

You must not accept any Flight Recorder which has ‘X’ as the first digit of its ident. This 

signifies a Flight Recorder which is not IGC approved (BGA Competitions Rulebook: Rule 

5.5.1). The data from such devices is not sufficiently secure, and they may not properly 

record pressure altitudes and engine noise levels. 

 

Motor gliders and turbo gliders must have the Pure glider box unchecked for the engine 

noise level checking to be enabled. 

Scoring a Competition Day 

Before launching commences: 

14. Check number of pilots competing. Any pilots no longer competing (i.e. formally 

withdrawn or disqualified from the competition) must be marked as withdrawn (see 

instructions below). This ensures that the correct number of participating pilots is 

used in daily points calculations. This will need to be done on each subsequent day 

on which the pilot is not competing. 

15. Obtain a forecast value for contest wind strength and direction for preliminary scoring. 

(BGA Competition Rulebook: Rule 5.23.5). Normally the forecast wind for 3000ft will 

be a suitable estimate for this purpose. 

16. If any gliders are being shared by more than one P1, note which pilot is flying as P1 

on that day. This information will be required when reporting overall contest results to 

the BGA. 

After launching commences 

 

Use Edit>Add Day to create a new contest day. 

 

On the Pilot list, Edit>Edit Performance for each withdrawn pilot and enter a lowercase w in 

their Day performance Tag box 

 

Use Edit>Day Properties and do the following: 

17. Select the Task tab and load the announced task in SeeYou Competition 

18. Select the Task Options tab and ensure that: 

o For Fixed Course , Enhanced Option Fixed Course Tasks and Distance 

handicapped Tasks: 

Type must be set to Racing Task and Task Time must be zero.                  

For Distance handicapped Tasks ‘use task from IGC file’ must also be 

selected. N.B For more help on scoring Distance Handicap Tasks please refer 

to the help files provided with the task setting software. 

o For AATs: 

Type must be set to Assigned Areas Task and Task Time is set to the 
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appropriate task time in hours and minutes.. 

 

The scoring script checks to see whether or not Task Time has been set. If Task 

Time is zero it will score a Fixed Course Task, if Task Time is not zero then it scores 

an Assigned Area Task. 

Note: The value selected for Type is not available to the scoring script. It can only 

deduce task type from the setting of the task time. Therefore, extra care should be 

taken to ensure that both values are correctly set.  

19. Select the Observation Zones tab and ensure that Observation Zones are set up 

correctly for the day’s task. Default values may not always apply (e.g. AAT, enhanced 

TP zones, alternate finish line). Check that missed observation zones tolerance is 

set to 0.5km. 

20. Select the General tab 

o in the Tag box, enter the estimate for Contest Wind in the form ddd/ss where 

ddd is the wind direction in degrees and ss is the wind speed in knots or for 

Distance Handicap Tasks enter ‘H’ followed by the Handicapped Task 

Distance, in the form Hddd.d (this ensures that the scoring script scores 

appropriately for the task type and does not need to apply handicaps or wind 

data to the pilots’ performances). 

After the above steps have been completed, ensure that the correct task information is being 

displayed in the header of the SeeYou Competition screen. Check that the class and task 

type are correct on the third line of the header.  

 

After Start Line Opening is Announced 

21. Use Edit>Day Properties and: 

o On the Task Options tab, enter the start gate open time under No start 

before 

o On the Observation Zone tab, select Start and enter the announced 

maximum start height (QNH) in the maximum altitude box. 

 

Preliminary Scoring 

As SeeYou Competition receives flight traces, it will analyse them for start/end times and 

completion of task and pass data to the scoring script for allocation of points. If ‘Auto 

evaluate’ is set, the software will monitor folders where flight traces are being downloaded or 

copied to and automatically score them as they are received. 

 

If using Soaring Spot or OnGlide, preliminary scores may be updated on the internet as they 

are received. 

Check any warning displayed in the right hand column against a pilot’s performance. Further 

detail on the warning may be displayed in the pane below the pilot performances. 

Typical warnings are: 
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22. User Wrng. This is displayed if the pilot has been flagged as withdrawn or if the flight 

has been scored manually. 

23. Fix Rate. Flight Recorder fix rate greater than the maximum allowed.  

Some Volksloggers, when set to a 12 second recording interval, may make very 

occasional fixes that are 13 seconds apart. This will be flagged by SeeYou but is not 

normally a problem. 

24. Alt Corr. The Flight Recorder pressure altitude was corrected by more than a limit set 

in contest properties (default 150ft) compared to takeoff height. 

25. No start found. Check start gate open time and examine trace to see if a valid start 

was made. SeeYou Competition does not accept a missed zone tolerance for starts, 

so it may be necessary to adjust the start line zone for this pilot (in View Flight) to 

force SeeYou Competition to score his flight, and then apply the appropriate penalty. 

26. Point ‘name’ not rounded OK. The named TP was missed but rounded within the 

missed zone tolerance (should be set to 0.5km). SeeYou Competition will score the 

flight as completed, but the appropriate penalty for a missed TP zone must be 

applied. If the TP zone was missed by more than missed zone tolerance, SeeYou 

Competition will score the pilot as having landed out at the most advantageous point. 

27. Start alt. Pilot has exceeded max start altitude within defined time limit prior to 

starting. 

28. High ENL. Engine noise level has exceeded limit set in Contest Properties. Check to 

determine whether or not this is engine running prior to start and, if not, that SeeYou 

has correctly detected ‘end of soaring’. 

29. Airspace violation found. If airspace checking enabled, pilot has infringed airspace. 

Details of the airspace infringed, and time of infringement will be displayed in the 

lower pane. 

If SeeYou Competition fails to score a pilot at all, then check that the correct flight trace has 

been submitted. On the first day it is probable that some Flight Recorder idents will be found 

to have been incorrectly recorded. Other common errors include the pilot submitting a trace 

with the wrong date, or an earlier flight before relighting, or an aerotow retrieve. Many pilots 

forget to set the date and time on EW Model ‘D’ recorders after a battery change, which 

results in a flight trace for a date in 1990 being submitted. It is possible to rename the file 

with the correct three digits for the day’s date. 

 

In some cases (such as failure to detect an engine start) you can force SeeYou Competition 

to land the pilot out at a fixed point by using Edit>Edit Performance to set an appropriate 

time for ‘end of soaring’. 

Manual Scoring 

If any pilots have launched as part of the competition but cannot provide a valid flight trace, 

then the following must be done in order to ensure that correct number of pilots launched is 

used in scoring calculations. 

Use Edit>Edit Performance to edit the appropriate pilot’s day performance, check the box 

Flight Evaluated Manually and enter a time for take-off (does not need to be accurate), and 

enter 0/0 in the Tag box. Also enter an appropriate note in the Comments box. 
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It is also possible to use manual scoring to score a pilot on a fixed course task, who has 

provided sufficient flight evidence, but SeeYou Competition has been unable to score it 

properly, for example if the start or finish have not registered properly. 

• As above, edit the pilot’s day performance, check the box Flight Evaluated Manually 
and enter a time for Take-off, Start and, for finishers, a Finish time. Enter n/d in the 
Tag box, where n is number of completed legs and, if non-zero, d represents the 
distance in kilometres remaining on an uncompleted leg (i.e. distance to next turn 
point). Do not enter any data in the Speed or Distance boxes; windicapped values 
for speed and distance will be calculated by the script using data entered in the Tag 
box 
 
For example, on a four leg task: 
  4/0  = all four legs completed i.e. finished the task. 
  3/38.6 = three legs completed and 38.6km of the fourth leg remaining. 
  2/0  = pilot completed two legs and landed at the second turn point 
 
Enter a note in the Comments box to indicate that the pilot has been manually 
scored and why. 

 

If you later want to re-evaluate a manually scored flight using the Flight Recorder trace then 

Edit>Edit Performance, click on the Reset button, clear the manual inputs, and then click on 

the Recalculate button. 

When Preliminary Scoring is Complete 

Day status must not be changed to Unofficial until: 

• Actual Contest Wind has been derived and scores recalculated using that value 

• All violations and warnings have been checked and appropriate penalties 

applied.(BGA Competitions Rulebook: Section 7.1) 

To derive Actual Contest Wind, use a representative sample (e.g. top 10 pilots) of flight 

traces to determine a suitable estimate for Contest Wind based on thermal drift. 

 

For each pilot in the sample, use Edit>Edit Performance>View Flight to access the 

standard SeeYou flight analysis tool, and on the Statistics page, the wind strength, direction 

and time spent in each 500ft height band is reported. Choose a representative height band 

for the day and use this to make up a sample of wind strengths and directions from which an 

average can be calculated. 

 

When the new value for Contest Wind is entered (in Edit>Day Properties), you will need to 

initiate a recalculation of the scores by selecting any pilot and using Edit>Edit Performance 

and clicking on the ‘Recalculate’ button. This will result in the windicapped distances and 

scores being recalculated for all pilots. 

 

When publishing the scores keep either a printed copy of the scores for your records, or take 

a copy of the appropriate HTML file in the SeeYou Competition day folder. 

After Issuing Unofficial Scores 
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Refer to BGA Competitions Rulebook: Section 5.24 When it has been agreed with the 

Director that scores can be published as Final, edit the Contest Day properties, and change 

status to Final, then publish the Final scores. As above, keep a copy of the published scores. 

Airspace Infringements 

Where an airspace infringement has been flagged, the flight trace should be assessed so 

that, if necessary, penalties can be applied. It is useful to have someone other than the 

scorer to undertake this assessment and report any actual infringements to the Director for 

follow up actions with pilots concerned and for determination of penalties to be applied in the 

Unofficial scores. 

 

When analysing flight traces it is best to ensure that SeeYou is set up to report all altitudes in 

QNH. This can be set in Tool>Options as described earlier.  

The following points should be noted: 

• altitudes stored by the Flight Recorder are based on pressure readings, and rounded 
to the nearest metre. 

• SeeYou calculates a take-off altitude by averaging a small number of pressure 
readings, immediately prior to launching. This gives a take-off height based on 
pressure relative to 1013.25 hPa. 

• SeeYou compares the calculated take-off altitude with the known airfield elevation, to 
calculate an offset which is then used to convert pressure altitudes in the flight trace 
to QNH altitudes (or QFE if selected). 
 
It also compares the take-off pressure altitude with the value entered for Day QNH 
and calculates the offset that must be applied to calculate QNE values for assessing 
Flight Levels. SeeYou Competition can flag instances where this offset is greater than 
a set limit (default is +/-150ft) 

• For any flagged infringement, first confirm that it is in a penalty area, and not in 
airspace that has been notified as being available to competitors. 

• If the pilot has infringed a penalty area, then determine the maximum extents of the 
infringement, vertically in feet, and horizontally in metres, by examining the flight trace 
using Edit>Edit Performance>View Flight, or by opening the Flight Trace directly 
with SeeYou. Use the standard SeeYou measuring tool to measure horizontal 
distances and read QNH altitudes from fixes, in the map or barograph view. 
 
Any reported Flight Level height infringements must be cross-checked against the 
nominal QNH altitude for the base of the Flight Level according to the Day QNE, to 
determine if this altitude was actually exceeded. 

• Using the Day QNE and Airfield Elevation, the nominal QNH for a Flight Level can be 
determined as follows. 

• If Day QNE is declared on the task sheets as 320ft, and Airfield Elevation is 410ft, 
then Nominal QNH for Flight Level 55 = (5500-320+410)ft = 5590ft QNH 
(See BGA Competitions Rulebook: Appendix 2). 

• Apply any penalties according to Section 34 of the BGA Competitions Rulebook. 
If a pilot protests the penalty, it may be necessary to reassess the infringement using 
a calibration chart. 

• Reference should be made to readings from the calibration chart for the altitudes 
closest to the take-off height and closest to the infringement height. Then divide the 
difference between the reference altitudes by the difference between the indicated 
altitudes on the calibration chart. This factor is then used as a representative value for 
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the average drift in accuracy over the desired altitude range.  
 
For example:  The take-off and maximum infringement altitudes are found to be 270ft 
and 3307ft respectively. 
 
The calibration chart for the Flight Recorder used shows reference altitudes of 0m 
and 1000m as nearest to these altitudes. At these points the calibration shows that 
the Flight Recorder actually reads -2m and 1007m respectively. 
 
Difference between reference altitudes divided by difference between indicated 
altitudes 
     = (1000 – 0) / (1007-(-2))  =   1000/1009  =  0.991 
 
Adjusted violation height = (0.991 * 3307)ft = 3277.237ft = 3278ft (rounding up) 
So the infringement in this case is reduced by 9ft. 
 
The manufacturer supplied calibration charts for some Flight Recorders (including 
most LX types) do not give a 0m reference point. In such cases it will be necessary to 
use only the reference altitude nearest to the infringement altitude and use the 
indicated error to adjust the infringement altitude. 
 

• In the above example, the indicated altitude at 1000m is 1007m, so the Flight 
Recorder over reads by 7m. 
Adjusted violation height = (3307 - (7*3.2808))ft = 3284.034ft = 3285ft (rounding up) 
So the infringement in this case is reduced by 22ft. 
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4.6.  Height Verification Procedure 

For checking for vertical infringement in airspace designated by flight level (eg. FL45), 

all logged heights will be referenced in any case to FL0. If an airspace infringement is 

indicated then the pilot must submit a valid calibration chart within the protest period to avoid 

an additional penalty in accordance with 5.5.7 as failure to provide a calibration chart will 

result in the assumption that the calibrated height puts any logged points 100 feet vertically 

further into the airspace than indicated with any airspace penalties varied accordingly. Any 

adjustment required by reference to the calibration chart is deduced by identifying the 

difference in error between calibrated chart reading at the 1013.25 HPa pressure altitude or 

that at the ambient test pressure altitude with that closest to height of infringement. In any 

case, the calibration will be used to reduce, eliminate, or increase the airspace penalty as 

appropriate. Where a chart shows a calibration at a particular test altitude more than once, 

the most advantageous calibration favouring the pilot should be used in all cases.  

For checking for vertical infringement in airspace designated by flight altitude above 

sea level (eg. 3500ALT), any verification software will correct all logged readings by the 

offset of documented airfield altitude from logged take-off height. If an airspace infringement 

is indicated then the pilot must submit a valid calibration chart within the protest period to 

avoid an additional penalty in accordance with 5.5.7 as failure to provide a calibration chart 

will result in the assumption that the calibrated height puts any logged points 100 feet 

vertically further into the airspace than indicated with any airspace penalties varied 

accordingly. Any adjustment required by reference to the calibration chart is deduced by 

identifying the difference in error between calibrated chart reading closest to airfield height 

compared to that closest to height of infringement. In any case, the calibration will be used to 

reduce, eliminate or increase the airspace penalty as appropriate. Where a chart shows a 

calibration at a particular test altitude more than once, the most advantageous calibration 

favouring the pilot should be used in all cases.  

For checking for vertical infringement of start height above airfield elevation (eg. 

4000ft QFE) or during the pre-start interval, any verification software will correct all logged 

readings by the offset of documented airfield altitude from logged take-off height. If an 

infringement is indicated, then the pilot may submit a valid calibration chart within the protest 

period. Any adjustment required by reference to the calibration chart is deduced by 

identifying the difference in error between calibrated chart reading closest to airfield height 

compared to that closest to height of infringement. In any case, the calibration will be used to 

reduce, eliminate or increase the airspace penalty as appropriate. Where a chart shows a 

calibration at a particular test altitude more than once, the most advantageous calibration 

favouring the pilot should be used in all cases. 
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4.7  Weighing Procedure 

In order to discourage pilots from either flying heavier than their maximum certificated mass 

or, in the case of the Club Class Nationals, at a mass greater than declared for handicap 

purposes, it is necessary to have in place the means to check weigh gliders either on the 

way to the grid or on the grid as seen fit. To enable this, it may be necessary within the Local 

Rules to set limitations when ballast may be loaded or dropped. As weighing is a time-

consuming operation it is expected that such weighing will be done on a random sample 

basis or when it is suspected that limits are being exceeded. A simple weighing procedure is 

specified in the Rules at 3.3.2 and states: - 

 "Gliders should be weighed with wings balanced and with all equipment required for 

flight. If weighing takes place on the way to the grid it must be ensured that the glider has 

a small into wind component. The mass of the pilot is also measured at this time. The 

intended take-off mass is the combined mass of glider, all equipment, pilot and any 

calibration error that is registered for the weighing scales in use.  A tolerance of +/- 1% is 

additionally allowed before overweight or out of handicap penalties are considered." 

Determining flight mass of gliders outdoors has errors associated due to wind strength and 

its direction relative to the wings so it must be assured that any benefit is given to the pilot so 

that in the event of being found overweight there is no doubt that this has occurred. 

Therefore, check weighing should only be contemplated when the wind is modest and the 

operation is set up in a direction that allows a wind component from leading to trailing edge 

of wing. If conditions do not permit weighing outside and there is a pressing need to weigh a 

glider, this should be done in a hangar. 

Directors expecting to carry out check-weighing at their competition should ensure that 

suitable equipment is available and tested beforehand. It is suggested that the advice of a 

local BGA inspector is sought on this matter well in advance of the competition.  
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4.8  Directors Report  

It is important to complete and submit your report, along with the results, as soon as possible 
after the competition. Please note that we are not seeking to ascertain the precise number of 
hand washbasins or toilets available during the competition! What we are seeking is 
information on all services provided, problems encountered, and events that occurred, as this 
information is used extensively by the Competitions and Awards Committee to assist in 
making any changes to the rules for the following year. 
  
Following the significant change to the airspace penalties and the ongoing infringements that 
have taken place year on year, it is now a requirement for the Directors report to include 
details of each and every airspace infringement including brief details of location and cause 
following interview with the pilot concerned. The Competition committee will be compiling this 
data for ongoing statistical purposes and to assess trends that might require action in future. 
  

DIRECTORS REPORT TEMPLATE 
 
ENTRY DETAILS  
A list of the number of competitors and classes. The handicap range of each class and the Entry Fees 
charged.  
 
RESULTS  
Please include pilots’ FAI No. and final position  
For team entries, it is very important to include both pilots’ FAI No, the points each scored on a daily 
basis and the day winner’s score. This is necessary so that the BGA pilot rating list may be compiled 
for the following year.   
 
ORGANISATION  
Please indicate where you had separate people in the following roles or explain shared roles. 
 

Role   Yes / No / Joint role with <specify> 

Director   

Assistant Director   

Task Setter   

Met  

Airspace  

Scoring  

Control   

Airfield Control  

Launch Marshall   

Safety Officer   

Tug Master   

Other, specify  
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TUGS  
The number of tugs available and the launch period. Any problems encountered in launching the task 
groups within the allocated time.  
 
FACILITIES  
  

Electricity in camping area?  

Catering?  

Bar?  

Events organised during week  

Last night party  

Other   

 
 
PILOT SAFETY COMMITTEE  
Any reported incidents. 
 
SCORING SYSTEM  
Scoring and analysis software used. Any problems encountered.  
 
COMPETITIVE FAIRNESS  
1)  The number and detail of any prohibited airspace penalties – in order to compile statistics and to 
review procedures, it is a requirement to fully document each and every infringement including the 
Directors view on the cause following interview with the pilot concerned. Ideally this should be in the 
form of a table as follows: 
 

Date Glider 
Type of 
Prohibited 
Airspace 

Penalty 
Points 

Description of 
Event 

Director’s 
Comment 

 
 
2)  Any protests involving the Stewards. 
3)  Any general issues around competitive fairness or other aspects of the rules which you would like 
the Comps Committee to review. 
 
ACCIDENTS/INCIDENTS  
A brief report on any accidents or incidents incurred during the competition.  
 
RECOMMENDATIONS  
A brief report on recommendations, interpretation of the rules, specific practices, you feel could be 
adopted by the Competition & Awards Committee for inclusion in the Competition Handbook.  
 
FORUM SUMMARY 
If you held a forum during your competition, please include a brief summary of the discussions in your 

report or advise who chaired the Forum. 

 
 
 


